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• Preface 
• About Mathematica 

Mathematica unites the following tasks, among others, in one uniform interactive environ­

ment: 

• the entry and display of mathematical formulas, 

• numerical calculation, 

• symbolic mathematics, 

• plotting functions, 

• contours and density plots 

• parametric plots of curves and surfaces, 

• creating graphics from elementary objects, 

• animating graphics, 

• list processing, 

• pattern matching, 
• functional, procedural and rule-based programming, 

• structuring documents hierarchically, 

• programming interactive documents. 

This is the ideal tool for those who use pure or applied mathematics, graphics, or program­

ming in their work. 

Mathematica is available for all the usual computer operating systems. Thanks to the 

uniformity of its file format, it is also a practical medium for the electronic exchange of 

reports or publications which contain formulas and graphics. Mathematica files, called 

notebooks, can also be saved directly into HTML format for easy publication on the World 

Wide Web. 

Mathematica allows you to solve many problems quickly, like calculating integrals, 

solving differential equations, or plotting functions. In order to use this powerful tool 
efficiently, however, you need to know the basics of the user interface and of the syntax of 

Mathematica expressions. Otherwise you would be like a driver who has not noticed that 

there are more gears than just first and that it makes sense to obey the rules of the road. In 

both cases its better not to attempt to learn by just trying things out. 
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• The Goals of this Course 

This book and the accompanying Mathematica notebooks on CD-ROM give you the 
basics of Mathematica in short form. We will discuss the user interface (front end), the 

most important functions built into the actual calculator (kernel), and some additional 

programs (packages) which come with Mathematica. The examples are kept at a simple 

mathematical level and to a great extent independent of special technical or scientific 

applications. Emphasis is put on solving standard problems (equations, integrals, etc.) and 

on graphics. 

After working through this course you will be able to solve your own problems indepen­

dently and to find additional help in the online documentation. Depending on your inter­

ests and needs, completing the first two parts of this course may be sufficient, as they 

include the most important calculations and graphics functions. The third part is more 

technical and the fourth introduces programming with Mathematica. 

• The Book and the CD-ROM 

The book is basically a direct printout of the corresponding Mathematica notebooks on the 

CD-ROM. Some things had to be left out like the colors, the animation of graphics, and 

also the hyperlinks within the notebooks to the online documentation of Mathematica and 

to Web sites. 

Why a book? Books are still the most ergonomic medium for the sequential study of 
texts-and today most of them are still lighter than a laptop computer. 

• What this Course Is Not 

This course is neither complete nor meant to be a reference tool. The four parts of the book 
therefore do not include summaries of the Mathematica commands discussed. However, 

the notebooks on the CD-ROM contain hyperlinks to online documentation of the com­

mands. The advantage being that you always see the documentation corresponding to your 

version of the program. 

A complete installation of the program includes the 1403 page "Mathematica Book" by 

Stephen Wolfram. This book is perhaps the first exception to the rule above: because of its 

size and format, comparable to a laptop, the electronic version, with its many useful 

hyperlinks, is usually more practical than the printed version. 



Introduction 11 

• Organization 

The introduction contains a short overview of Mathematica's capabilities and-for 
minimalists-a summary of the most important commands. The following four parts form a 

progression and should therefore be done in sequence. It is not necessary, however, to 

complete all the parts in one go. The methods in the first two parts will already allow you 

to solve many problems. The motivation for studying the last two parts will probably arise 
after you have worked with the program for a while. 

The first part leads to the most important capabilities of the user interface (front end) and 

explains the different possibilities for creating Mathematica entries and formulas. Next, 

how to tackle the most common problems is shown using examples: numerical calculation, 
manipulation of formulas, solving equations and differential equations, calculating limits, 

derivatives and integrals. 

The second part deals with an especially compelling aspect of the program: plots of graphs 

of functions and parametric plots of curves and surfaces. Many of these features are built 

into the Mathematica kernel; additional useful tools are available from standard packages. 

The third part starts with a discussion of lists. They are used to manipulate vectors and 

matrices; they also appear in many Mathematica functions as arguments or results, and can 

be used to structure data. In connection with this, this part also deals with mapping 
functions on lists and simple calculations of linear algebra. Lists allow you to assemble 

graphics from graphics elements (lines, circles, etc.). Sequences of graphics can be 

animated. 

The fourth part is aimed at users who want a more in-depth study of Mathematica. It is the 
starting point for the independent development of complicated programs. The first three 
chapters are dedicated to the structure and evaluation of Mathematica expressions. Based 

on this, we discuss different possible programming methodologies and the tools for their 

application. At the end you will find leads to further information such as relevant Web 
sites and a link to Mathematica literature. 

Several chapters include in-depth paragraphs covering special features and technical 

details, which can be left out at first. 

The exercise problems have been kept simple on purpose. They should allow you to 

master the program without getting bogged down in complicated mathematics. The ideal 

exercise examples are not found in the book-they develop from your work. There are 

many problems which you can solve with Mathematica. Try it! 
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• Tips 

For best results, the notebooks should be worked on directly in Mathematica on the 

computer. If you do not own the complete program, you can use the program MathReader, 

which is included on the CD-ROM, to access the notebooks (and the animations). Math­

Reader is a reduced version of Mathematica which cannot be used to make calculations 

but which does give you a first impression of how the program works. 

When using the full version, it is best to use the files in the In-only directory; for 

MathReaderuse the files in In-out (see the paragraph "The Files on the CD-ROM"). 

It is important to know that the cell groups (shown as square brackets on the right-hand 

side of the notebook window) can be opened or closed by double-clicking on the bracket 

itself, or by using the command Cell> Cell Grouping on the menu bar. 

With the menu Format> Magnification you can adjust the magnification of the window 

for maximum overview and readability. Graphics might then appear jaggy. Use the 

command Cell> Rerender Graphics to smooth them out again. 

With the computer you can use the hyperlinks to access the documentation of built-in 

functions, or to jump from one section of the book to another. The menu Find> Go Back 
is useful here: it takes you back to the original hyperlink. Depending on the version and 

the installation options of Mathematica, certain links are inactive. The links in the table of 

contents and the subject index are useful to navigate between the notebooks. 

It is best to start with the examples in the chapter "A Short Tour" (in the 
Introduction. nb file). With the full version of Mathematica the input cells can be 

evaluated using the <Enter> key (or <Shift> and <Return». In the "Short Tour", and 
during the whole course, you are invited to change the examples in order to test the 

possibilities and limits of the program and to get used to the syntax. 

It will quickly become obvious that a lot can be done with the commands in the "Short 

Tour", but that much remains unclear. This will motivate you towards a systematic and in­

depth study of the program using the rest of the course sections. 

• The Files on the CD-ROM 

The CD-ROM can be used with MacOS, Windows 95/98/NT, or UNIX. It contains the 

Mathematica notebooks from the book in different versions, as well as (for MacOS and 

Windows) the program MathReader, with which the notebooks and the animations can be 

viewed but not changed. 

The file Info. txt contains up-to-date information. 
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The actual notebooks are named according to their contents: 

• Contents. nb, 

·Introduction.nb, 

• Part-l. nb to Part-4. nb, 

• Index.nb. 
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They are filed in two versions: with and without the Mathematica output cells. The files 

with the output cells (In-out folder) are much larger than those without (In-only 

folder), mainly because of the graphics. 

If you work with the complete version of Mathematica, it is best to use the notebooks that 

contain only the input cells (In-only folder). You can evaluate them using the <Enter> 

key (or <Shift> and <Return» and thus reproduce the full notebook. 

The files in the In - ou t folder contain all the input and output cells. They are meant to be 

viewed with MathReader. 

The second and third sections contain the most graphics. Depending on the magnification 

and the number of graphics and animations already viewed, Mathematica or MathReader 

will need a large amount of memory. It is therefore recommended to only have one 

notebook open at a time. If you are using a computer with static memory assignment 

(Macintosh) you should assign Mathematica or MathReader as much memory as possible. 

In doing so a compromise between the front end (Mathematica) and the kernel (MathKer­

nel) must be found. 

• Information About this Book on the World Wide Web 

Up-to-date information and any corrections to the book and the files on the CD-ROM can 
be accessed on the Web at http://www.ifm.ethz.ch/-kaufmannl . 

• Technical Information 

The notebooks were created and evaluated with Mathematica 3.0.1 on a PowerMacintosh 
86001200. The beginning of each new kernel session can be identified by the numbers of 

the input cells (In[ ... D. 

The Postscript files used to print the book were created directly from the notebooks using 

a test version of Mathematica 4.0 (which allows automatic hyphenation). 

The format is based on the default Style Sheet (Format> Style Sheet> Default), with 

some additional header and body text styles. 



14 

The only difference to the default settings of the kernel is a new definition of $Defaul t­

Font, created to use a smaller font size in the graphics. The definition reads: 

$DefaultFont = {"Courier" I 9} 

It was added to the ini t . m file in the Conf igura tion/Kernel subdirectory of the 

Mathematica installation folder. 

Using the Option Inspector (Format menu), the ImageSize for normal graphics was 

set at 250x250 points, and at 220x220 points for the smaller graphics in the exercise and 

in-depth sections. Further changes in ImageSize were added directly in each graphic 

command and can be deleted during your work with the notebooks. 

In the notebooks in the In-out folder (see "The Files on the CD-ROM") the option 

CellLabelAutoDelete was set to False with the Option Inspector, so that the 

numbers of the input and output cells would remain after closing the notebooks. 

The subject index was created with a test version of the AuthorTools package from 

Wolfram Research. 
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• A Short Tour 

This section introduces the most important features of Mathematica, using simple exam­

ples. 

• Formula Entry 

Formulas can be entered using various techniques with palettes or using only the keyboard. 

• Entries Using Palettes 

The menu File > Palettes > BasicInpnt displays a palette with the simplest formulas on­

screen. You can use this to create an exponent, for example. 

Now enter 2. 

Use the tab key to jump to the next placeholder and enter 3. 

Pressing the <Enter> key (or <Shift> and <Return>: ~~) evaluates the cell. 

Out[1]= 8 

• Entries Using the Keyboard 

The exponent can also be written using A. This gives us the equivalent keyboard entry. 

In[2]:= 2 A 3 

Out[2]= 8 

Even the "two-dimensional" 2 3 can be done on the keyboard: enter 2 ~A 3. 

In[3]:= 2 3 

Out[3]= 8 

S. Kaufmann, A Crash Course in  Mathematica
© Birkhäuser Verlag 1999



Introduction 17 

• Numerical Calculations 

Mathematica is not only a formula editor but also an expensive pocket calculator that can 

still do a thing or two. 

• Exact Arithmetic 

We can calculate with exact integers and rational numbers of any size. 

In[4]:= 2 512 

Out[4]= 13407807929942597099574024998205846127479365820592 3 933 77723 5 ... 
61443721764030073546976801874298166903427690031858186486050\ 
853753882811946569946433649006084096 

In[5]:= 2 A 10 / 10 A 3 

Out[5]= 
128 
125 

• Arithmetic with Approximate Numbers 

Numerical approximations of varying precision are possible. 

In[6]:= N [71", 200 1 

Out[6]= 3.14159265358979323846264338327950288419716939937 5105 82 097 49··. 
44592307816406286208998628034825342117067982148086513282306\ 
64709384460955058223172535940812848111745028410270193852110\ 
55596446229489549303820 

• Arithmetic with Complex Numbers 

Complex numbers are entered using the imaginary unit I (or i). 

In[7]:= (1 + 3 I) A 2 

Out[7]= - 8 + 6 I 

• Symbolic Mathematics 

By using symbol names instead of numbers we get mathematical expressions. These can 

be manipulated, just like calculations "by hand". 
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• Polynomials 

This is a polynomial in three variables: 

In[8]:= (a + b + c) "5 

Out[8]= (a + b + c) 5 

The Expand function expands it out. 

In[9]:= Expand [ (a + b + c) "5] 

Out[9]= a 5 + 5 a 4 b + 10 a 3 b 2 + 10 a 2 b 3 + 5 a b 4 + b 5 + 5 a 4 c + 20 a 3 b c + 

30a2 b 2 c+20ab3 c+5b4 c+10a3 c 2 +30a2 bc2 +30ab2 c 2 + 

10 b 3 c 2 + 10 a 2 c 3 + 20 a b c 3 + 10 b 2 c 3 + 5 a c 4 + 5 b c 4 + c 5 

• Equations 

We solve the equation x 3 + r - x + 1 = 0 for x like this: 

In[10]:= Solve[x3 +X2 -x+l == 0, x] 

{{x~-~- 4 1 -f33 1/3 Out[10]= -f33 1/3 
-3(19-333) }, 

3(19-333) 

{x~-~+ 2 (l+IY3) 1 
(l-IY3) -f33 1/3 

(19 - 3 -/33) 1/3 
+ - (19-333) }, 

3 6 

{x~-~+ 2 (l-IY3) 1 
(l+IY3) -/33 1/3 

-/33 1/3 
+ - (19-3 33) }} 

3(19-333) 6 

The function FindRoot returns an approximate solution of a transcendental equation. 

In[11]:= FindRoot [Sin[x] + 1 == x, {x, 2}] 

Out[11]= {x ~ 1. 93456} 

• Derivatives 

The following expression calculates the derivative of xSin(x«>S(x») for x. 

In[12]:= D [x"Sin [x"Cos [xl l, xl 

Out[12]= xSin[xCOS[xi] Cos [xcos[x] 1 Log [xl 

(x-1+COS [x] Cos [xl - XCos[x] Log [xl Sin [xl) + x_1+sin[xCos[xi] Sin [XCOS[x] 1 
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• Integrals 

Using the template from the palette BasicInput, we create an integral and calculate it. 

In[13]:= 

Out[13]= 
3 x 2 6 (3 + 4 x) 

-6x--2-+ 5(-1-x+x2) + 

152 ArcTanh [ -l?sX_] 
----~=-'-~-=-- - 7 Log [ -1 - x + x 2 ] 5rs 

This is another way of writing integrals: 

In[14]:= Integrate [Sin [xl A3 COS [xl A2 Exp [xl, xl 

1 
Out[14]= 2080 (EX (-130Cos[x]-39Cos[3x] + 

25Cos[5x] +130Sin[x] +13Sin[3x]-5Sin[5x])) 

• Graphics 
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Various graphics functions can be used to visualize mathematical functions and mappings 

(or data) in all ways imaginable. 

• Two-Dimensional Graphics 
2 

First we plot the graph of the function x ~ x: _;:;~ 1 in the interval [-10, 10]. 

x 2 - X + 3 
In[15]:= Plot [ -, {x, -10, 10}] 

x 3 _ 2 x 2 - 1 

-5 .5 5 7.5 10 

-4 l -6 

-8 

Out[15]= - Graphics -
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This parametric plot creates a spiral: 

In[16]:= ParametricPlot [ {III Cos [III], III Sin [III] }, {III, 0, 2 7r} ] 

-2 2 4 6 

-1 

-2 

-3 

-4 

Out[16]= - Graphics -

• Three-Dimensional Graphics 

The following command plots the graph of the function (x, y) ~ sin(x y). 

In[17]:= Plot3D[Sin[x*y], {x, 0, 2*Pi}, {y, 0, 2*Pi}] 

Out[17]= - SurfaceGraphics -

The peaks can be smoothed out by increasing the number of function values calculated 

initially. We also use a more elegant way of writing the input: 
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In[IB]:= Plot3D[Sin[xy], {x, 0, 27T}, {y, 0, 2 7T}, PlotPoints -+ 40] 

Oul[IB]= - SurfaceGraphics -

Functions of two variables can also be visualized using contours. 

In[19]:= ContourPlot [x2 - y2, {x, -2, 2}, {y, - 2, 2}, PlotPoints -+ 30] 

Oul[19]= - ContourGraphics -

• Animated Graphics 

Sequences of graphics can be animated on-screen. This expression creates a graphic 

sequence of two colored lines: 
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t 
In[20):= Table [Show [Graphics [ {Thickness [0.05], {Hue [ -- ], Line [ 

7r 

t 1 
{-{Cos[t], Sin[t]}, {Cos[t], Sin[t]}}J}, {Hue[--+-], 

7r 2 
Line[{{-Sin[t], Cos[t]}, {Sin[t], -cos[t]}}J}}], 

PlotRange -+ {{ -1, I}, {-I, I}}, AspectRatio -+ Automatic, 
7r 7r 7r 

ImageSize -+ 150], {t, 0, - - -, -}]; 
2 30 30 

Double-clicking the graphic rotates the cross. The book shows only the first position. 

Therefore another representation of all 15 positions is given below: 

In[21):= Show[GraphicsArray[Partition[%, 5]]] 

-++-\- \ 
\\ 
'A -L--

Out[21)= - GraphicsArray -

• Programming 

Mathematica is a powerful high-level programming language that supports functional and 

rule-based programming as well as the usual procedural programming styles. 
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As an example let us look at a program for the recursive calculation of factorials. All we 

need are the following two definitions: 

In[22]:= fac [0] = 1; 
fac [n_] : = n fac [n - 1] 

The result for 100! yields 

In[24]:= fac [100] 

Out[24]= 933262154439441526816992388562667004907159682 643 816214 6 8592 9 ". 

63895217599993229915608941463976156518286253697920827223758\ 
251185210916864000000000000000000000000 

and matches the one produced by the built-in factorial function: 

In[25]:= lOa! 

Out[25]= 933262154439441526816992388562667004907159682 643 816214 68592 9· 

63895217599993229915608941463976156518286253697920827223758\ 

251185210916864000000000000000000000000 

• Some of the Most Important Functions 

This short overview only gives a quick description of 33 important Mathematica func­

tions. The selection must be arbitrary because there are more than 1600 objects built into 

the kernel of Version 3.0. The online documentation in Mathematica (see Section 1.2) 

contains more precise and up-to-date information on all built-in functions. In the notebook 

you can just click on the hyperlinks to get there. 

• Numerical Approximations 

N[X] numerical approximation of an expre 

N[x, n] numerical approximation with n digits 

• Constants 

Pi 71' ~ 3.14159 
E e ~ 2.71828 

I i=r-I 
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• Elementary Functions 

quare root Sqrt[x] 

Exp[x], Log[x] exponential function, natural logarithm 

Sin[x]. Cos [x], Tan[x] trigonometric function 

Sinh[x], 000 hyperbolic functions 

ArcSin[x], 000 

ArcSinh[x], 0.0 

inver e trigonometric function 

inverse hyperbolic functions 

• Manipulation of Expressions 

Expand[x] 

Factor[x] 

SimplHy[x], FullSimplify[x] 

expand out 

factor 

simplify 

• Solving Algebraic Equations 

Solve[/s == rs, xl 
Solve[lgl.g2 ... J.lxl' X2, .. oj] 
FindRoot[g, {x, xo)) 

• Calculus 

Limitlf, x -> .to] 

D[f, x] 

Integrate[j, xl 

Integra te[j, lx, X",i", x"'(U)] 

DSolve [ 

x' [ t] == x [ t ] I x [ t ] I t ] 

NDSolve [ 

olve the equation Is = rs for x 

olve a y tern of equation 

find a numerical root; the initial value i Xo 

the limit of f for x ~ Xo 

the derivative of f with re peet to x 

the indefinite integral of f 
the definite integral in the interval [Xmin, x"'(U] 

olve the differential equation 

x (I) = X(/) for X(/) 

{ x' [ t ] = = x [ t 1 I X [ 0 1 = = 1}, 

x [ t l , {t I t min I t max } 1 

find a numerical oolution to the differential 

equation x (t) = x(t) with the initial 

condition xeD) = I in the interval [tmin , tllUl.lo] 
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• Plots 

Plot[f. {x. Xmin' Xmax}] 

Plot3D[f. {x. Xmin. Xmax I. 
{Yo Ymin' Ymax II 

plot a function of one variable 

plot a function of two variable 

ContourPlot[f. {x. Xmin. Xmax I. draw a contour plot of a function of 

{y, Ymin' Ymax J] two variables 

ParametricPlot[{f ... f y l. draw a parametric curve in the plane 

(t, tmin' tmax j] 

ParametricPlot3D[(/x, f y, h), draw a parametric curve in space 

{t. (min' (max)] 

ParametricPlot3D[(/x. f y , hI, draw a parametric urfacein pace 

(u, Umin' umax ), {v, Vmin' vmax }] 

• Lists and Matrices 

Table[j Ii, imin , im•x }] create a Ii t; 

Inverse[m] 

Det[mJ 

m.l1 

the iterator i run from im;" to imwc in increments of 1 

lh inver e of a matrix 

the determinant of a matrix 

matrix product 
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Part 1 : The Basics 

This part deals with the basics: the structure of the program, online documentation, input 
variations, as well as simple numerical calculations and symbolic mathematics. 

S. Kaufmann, A Crash Course in  Mathematica
© Birkhäuser Verlag 1999
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• 1.1 The Structure of the Program 

Mathematica consists of two programs which can work independently of one another and 

even on separate computers. The two programs are called: front end and kernel. 

• 1.1.1 The Front End 

Front end is the user-friendly interface with which Mathematica documents, called 

notebooks, can be created and edited. The many commands which are accessible via 

menus are documented in the Help Browser (menu Help) under Other Information> 

Menu Commands. 

We launch the front end by double-clicking on the Mathematica icon (or using the mathe­

matica command). 

For actual calculations (after hitting the <Enter> key or ISHIFTI[BIT]) the front end connects to 

the kernel, sends it the expressions to be evaluated, receives the results, and nicely dis­

plays them. 

• Cells and Styles 

The front end arranges the notebooks into hierarchically grouped cells. Cells and their 

groupings are shown by the brackets on the right-hand side of the notebook. Cell groups 

can be opened and closed by double-clicking on the brackets, or with the Cell > Cell 

Grouping menu command. A new cell is created by clicking between two existing cells 

(or below the last cell) and typing the data to be entered. 

Each cell has a style (menu Format> Style). The notebook uses predefined styles (For­

mat> Style Sheet), which can be changed for every notebook using the style sheet or just 

for the current notebook (Format> Edit Style Sheet ... ). In the default notebook (Default) 

you can access, among other things, a hierarchy of title styles, text in two sizes, and styles 

for input and output cells. 

Normally, if Cell> Cell Grouping is set to Automatic Grouping, the program organizes 

the cells automatically according to style by grouping cells between two titles, subtitles, 

etc., together. 
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• In Depth 

• The Best Way to Organize Cells 

Text cells should contain one paragraph per cell. 

Keeping each Mathematica expression in a single input cell gives a better overview of calculations. 

If necessary you can also combine several expressions divided by semicolons in one cell. 

• Exercises 

• Using the Front End 

Adjust the size of the notebook window to make it easier to read or to optimize the overview (menu 

Format> Magnification). 

Open a new notebook (File> New). 

Enter a title into a cell formatted for titles. You can either ftrst choose the style (menu Format> 

Style) and then type, or ftrst type (the cell will be formatted as input) and then select the cell bracket 

and change the style. 

Below this, enter a section heading into a section cell. (Position the new cell by clicking below a cell 

or between two existing ones.) 

Below this, enter text into a text cell. 

Below this, enter a new section heading into a section cell. 

Below this, enter a calculation (for example 1+1). 

Evaluate the above cell using the I SHIFT I [BIT] keys or by pressing <Enter>. 

Note the automatic grouping of all cells. 

Open and close some of the cell groups. 

Save the notebook as a me (File> Save As ... ) 

Select a different pre-deftned style sheet (Format> Style Sheet) and note the change in appearance 

of the notebook. 

• 1.1.2 The Kernel 

The kernel does the actual calculations. Normally you access it using the front end. It can 

also be launched by itself (by double-clicking on the MathKernel icon or using the rna th 

command). 
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When an input cell is evaluated using <Enter>, ISHIFTI[BIT], or the Evaluate Cells command 

(menu Kernel> Evaluation) a kernel is launched and the automatic numbering of input 

and output cells begins at 1. During a kernel session, you will usually enter definitions 

(e.g., aConstant=3 .1). These remain active until the end of the session if they are not 

explicitly cleared. Once you quit the kernel, all definitions are lost. You can reactivate 

them in the next session by evaluating the corresponding cells again. 

Cells in a notebook can be evaluated in any order; it does not have to be from top to 

bottom. This may, however, give different results than if the notebook is evaluated sequen­

tially (using for example the Kernel> Evaluation> Evaluate Notebook). 

When you open a new notebook without quitting the front end, you continue to use the 

same kernel, which means that all definitions remain active. It is possible to configure 

additional kernels as necessary (Kernel> Kernel Configuration Options> Add) and to 

associate them to specific notebooks (Kernel> Notebooks Kernel). The kernels can also 

run on other computers. 

When you quit the front end, the kernel processes stop automatically. Single evaluations 

can be aborted as necessary (Kernel> Abort Evaluation), or whole kernel processes can 

be terminated without quitting the front end (Kernel> Quit Kernel). 

• In Depth 

• Communication between Front End and Kernel 

The protocol used for the communication between the front end and the kernel is called MathLink. It 

can also be used to communicate between Mathematica and other application programs (see Help> 
Add-Ons> MathLink Library). 

• Exercises 

• Starting and Aborting Evaluations 

Start the following infinite loop: 

While[True, 1] 

Then abort it. 

• Quitting the Kernel 

Start the evaluation again. 

Then quit the whole kernel process. 
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• 1.2 Online Documentation 

The Help menu contains several help commands. In addition to registration information 

and explanations of error beeps made by the computer (Why the Beep? .• ), you can open 

the Help Browser window to navigate through the online documentation. It is organized as 

follows: 

Built-in Functions: organized by subject. 

Add-ons: functions from packages that can be added to the program (see Loading 

Packages). 

The Mathematica Book: the electronic version of the (1403 page) book by Stephen 

Wolfram. This is very useful, thanks to the hyperlinks. 

Getting StartedJDemos: various information and demonstrations. Have a look at it! 

Other Information: front end menus, keyboard shortcuts. 

Master Index: alphabetical index of all built-in functions. 

You can access the different information using either the search function (enter text, select 

Go To), or by clicking on the hierarchically structured subject names. You also have the 

very useful option of selecting a function name in your notebook and accessing the 

documentation via the menu Help> Find in Help •.. (or> Find Selected Function ... ). 

An incomplete installation of Mathematica can result in missing parts of the documenta­

tion (for example the book, which takes up a large portion of the hard drive). 

• Exercises 

• Self Study 

Open the Help Browser. 

Study the organization of the Built-in Functions. 

Note the underlined terms in the body text which indicate hyperlinks. After using a hyperlink, you 

can go back to your original location with the Back button or the menu Find> Go Back. 

Have a look at the section "Mathematica as a Calculator" in the "Tour of Mathematica" (Getting 

StartedIDemos). 

Have a look at the subsection "Power Computing with Mathematica" of the section "Tour of 

Mathematica" in the Mathematica Book. 

Study the documentation of the front end command Find> Find .••. 
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Read the introduction to working with standard packages (Add-oDS> Working with Add-ons> 

Loading Packages). 

• Packages 

The standard packages that come with the program contain many useful tools in addition to the 

functions built into the kernel. To use them you must first load the corresponding package. 

Load the package Miscellaneous' ChemicalElements'. 

What is the atomic weight of plutonium? 

• 1.3 Formulas 

• 1 .3.1 Formats 

Input and output cells can basically be shown in three formats: InputForm, Standard­

Form, and Tradi tionalForm. 

In this course we use InputForm or StandardForm, depending on the circumstances. 

• InputForm 

Inpu tForm is useful for keyboard entries. (In early versions of Mathematica this was the 

only form of entry.) Mathematica functions are used by typing their names and placing 

their arguments inside square brackets. Further conventions are discussed below. 

For example, the command for the integration of x (sin x) in InputForm looks like this: 

Integrate [x Sin [x], x] 

The documentation of functions in the Help Browser is always shown in InputForm. 

• StandardForm 

StandardForm is more similar to normal mathematical notation. It is unambiguous, 

unlike Tradi tionalForm. Integrals are written with the integral sign: 

f x Sin [x] dlx 
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You can create input in StandardForm using either palettes or keyboard shortcuts-or 
by converting an InputForm cell to StandardForm (menu Cell> Convert To > 

StandardForm) . 

• TraditionalFor.m 

TraditionalForm follows the usual mathematical notation. The names of mathemati­

cal functions like "sin" are written in lower case, variables are in italics, and arguments are 

placed in round parentheses. 

f x sin(x)dx 

Unfortunately, this style contains many ambiguities which appear in mathematical texts, 

where they are resolved by the context or by implicit conventions. It is usually clear that 

the formula 

a (b +c) 

means the product of a multiplied by the sum of band c. It is also normal to use 

f(x) 

for the application of the function f on the argument x. But how do we interpret the 

following formula: 

f(b +c) 

Is this the function f applied to the argument b + c or the constant f multiplied by b + c? 
Mathematica cannot answer this question. For similar reasons, the special symbol d is 

used in integrals. 

It is advantageous, therefore, to use only InputForm or StandardForm for input cells. 
Output cells can be generated in Tradi tionalForm as needed, either by converting the 
cell (Cell> Convert To > TraditionaIForm), or by using the option Cell> Default 

Output FormatType > TraditionalForm . 

• Converting Cells 

The following commands in the menu Cell are the most interesting for converting and 

displaying output cells : 

Convert To: converts the selection to the format chosen. 
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Display As: displays the selection in the new format. Fractions, superscripts, etc. are not 

converted (unlike with Convert To). 

Default Output FormatType: output cells are created in the format selected. 

• Exercises 

• Converting Formats 

A derivative is written using the function name D in InputForm. The arguments are placed in 

square brackets and separated by commas. The first argument is the expression to be derived, the 
second is the variable to be used for the derivative: 

O[Sin[2x+a], x] 

How is the derivative written in StandardForm or in Tradi tionalForm? 

A second derivative looks like this in Inpu tForm: 

O[xSin[x A 3], {x, 2}] 

Which are the other two forms of display? 

• 1.3.2 Entering Formulas and Special Characters 

There are basically three methods for the easy entry of formulas and special characters. 
They can also be combined: 

• using palettes, 
• using control and escape key combinations, 

• typing first in InputForm and subsequent conversion if necessary. 

Mathematica contains a useful feature for working with formulas: a selection is enlarged 

hierarchically by repeatedly clicking on it. 

• Palettes 

The menu File> Palettes contains some useful pre-defined palettes. 

AlgebraicManipulation: this is a compilation of several often-used functions for the 

algebraic manipulation of formulas, such as the expansion and factoring of polynomials 

and the simplification of expressions. Clicking the button on the palette automatically 

applies the function to the selection in the notebook, evaluating "on location". 

BasicCalculations: contains the most important commands for simple calculations. 
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BasicInput: it makes sense to leave this palette on your screen. It contains the most-used 

symbols (Greek characters, etc.) and formulas (derivatives, integrals, etc.). 

BasicTypesetting: an alternative or supplement to Basic Input containing many symbols, 

but no formulas. 

CompleteCharacters: almost all special characters imaginable, organized by subject. 

InternationaiCharacters: this palette is useful if the needed international characters are 

not on your keyboard. It contains umlauts, etc. 

NotebookLauncher: creates a new notebook with a chosen pre-defined style (analogous 

to the menu Format> Style Sheet). 

Placeholders indicated by a _ are filled out automatically with the current selection. The 

jump to the next placeholder can be shortened using the ~ key. 

• Control and Escape Key Shortcuts 

Fractions, SUbscripts, etc. can also be created using the [@ «Control» key in simulta­

neous combination with certain other keys. These shortcuts are shown in the menu Edit> 

Expression Input. The shortcut [@2 gives a square root whose radicand is entered 
automatically as you continue typing: 

Many symbols can be written using escape sequences of the form rnkeyrn. You find the 
necessary keys in the BasicTypesetting palette by pointing at the desired symbol. To get 

Greek characters the analogous Latin key must be hit between the rn keys. Typing rnarn 
therefore gives you an a. 

Within nested formulas you can go back to the last level using [@~ «Control>- and 
spacebar). Therefore the key sequence [@/ a [@A x [@~ +b ~ c gives you the 

formula: 

c 

• Using InputForm 

As mentioned in the paragraph about formats, all input cells can also be written in the 

linear InputForm. If needed you can convert formulas into the two-dimensional Stan­

dardForm. In this case, roots and exponents look like this: 
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Sqrt [a] + b'" 3 

After you select Convert To > StandardForm the cell becomes: 

Greek characters can also be entered using \ [name]. If you replace name with Alpha 

you get an a. 

InputForm and StandardForm formats can be combined with no problem: 

f Sqrt [x] dlx 

- In Depth 

• Creating Palettes 

You can create your own palettes in three simple steps: 
o select Input> Create Palette, 
o fill out the palette and select it, 

o select File> Generate Palette from Selection. 
The _ placeholder is created with ~spl~. It will automatically be replaced by the current 

selection. A normal 0 placeholder is written as ~pl~. 

In order for the palettes to appear in the menu File > Palettes, save the files in the subdirectory 
Configuration\Front End\Palettes of Mathematica's installation directory or in the 
subdirectory Front End/Palettes of your personal Mathematica directory (for Mathematica 

3.0 on a UNIX system, this would be: - / . Mathematica!3 . 0) 

• Formulas Embedded in Text 

As you see in this book, formulas can also be embedded in text cells. Here is an example: Y x2 + I . 
To achieve this, you can either copy an input or output cell which uses your favorite format 

(normally Tradi tionalForm) and paste it into the text cell. Or you open a placeholder box in the 

text cell with 1QBh]9, use IQBh] and ~ keystrokes to create the formula, and leave it with 1QBh]~. 

- Exercises 

• Self Study 

Take a look at all the available palettes. 

Study the keyboard shortcuts in the menu Edit> Expression Input. 

• Writing Formulas 

Create the following formula with three different methods: using palettes, using IQBh] and ~ keys 

combinations (wherever possible), and by converting from InputForm. 
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f x 2 Sin [xl elx 

1" 7T 
sin [xl Cos [x - -] elx 

o 4 

0*_1_ 
~ 

• Hierarchy 

Click several times on one of the formulas created above and see how the selection is enlarged 
hierarchicall y. 

• Palettes 

Study the in-depth section "Creating Palettes". Then create your own palette. A simple example 
could be: 

• 1.4 Simple Calculations 

Now we will begin with actual calculations. You can reproduce them on your computer 

using the ISHIFTlffiITl or <Enter> keys. 

• 1.4.1 Conventions 

First we deal with the most important conventions in Mathematica. It is advisable to read 

this chapter quickly at first, and later, when you have made your own calculations, to study 

it more carefully. 

• Names 

Mathematica is case sensitive. 
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In[l]:= a - a 

Out[l]= 0 

In[2]:= a - A 

Out[2]= a - A 

The names of built-in functions are (in InputForm) written with the first letter of each 

word capitalized. Each part of a compound word also begins with a capital. 

In[3]:= Expand [ (a + b) "2/ (c + d) "2] 

Out[3]= 

(a + b) 2 

In[4]:= ExpandAll [ ---­
(c + d) 2 

~ 2ab ~ 
Out[4]= c2 + 2 cd + d 2 + c 2 + 2 cd + d 2 + c 2 + 2 cd + d 2 

To avoid conflicts between names of built-in Mathematica functions and other objects, 

you should begin your own names with a small letter. 

In[5]:= myFunction 

Out[5]= myFunction 

In[6]:= x 

Out[6]= x 

Spaces L) can be used as long as they do not change the meaning of expressions. 

In[7]:= a- a 

Out[7]= 0 

But: 

In[B]:= aa/ a 

Out[B]= 
aa 

a 
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In[9):= a a / a 

Out[9)= a 

(The space between the two a's indicates that the product a * a is meant-not the symbol 
named aa.) 

• Parentheses, Brackets, and Braces 

Arguments of Mathematica functions are placed in square brackets and separated by 

commas. 

In[10):= J:ntegrate [x"n, x] 

Out[10)= l+n 

Parentheses are used for mathematical grouping. 

In[11):= 1/ (a + b (c + d» 

1 
Out[11)= 

a+b (c+d) 

Lists are placed in curly braces. They can be used, for instance, to define vectors. Lists are 

often also requested as arguments for built-in functions. 

In[12):= {a, b, c} 

Out[12)= {a, b, c} 

In[13):= J:ntegrate [x" 2, {x, 0, 1}] 

1 
Out[13)= 3 

The elements of lists are numbered from left to right, starting with 1. Double square 

brackets (InputForm) or [ ... ] brackets (StandardForm) are used to extract elements 

from lists. 

In[14):= {a, b, c} [ [1] ] 

Out[14)= a 

In[15):= {a, b, c} [2] 

Out[15)= b 
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Lists can also be nested: 

In[16):= {{a, b, c}, {d, e, f}} 

Out[16)= {{a, b, c}, {d, e, f}} 

To access a single element, we first indicate the position within the outer list, then the 

position in the corresponding sub list. 

In[17):= {{a, b, c}, {d, e, f}} [[1, 2]] 

Out[17)= b 

In[18):= {{a, b, c}, {d, e, f}} [[2, 3]] 

Out[18)= f 

• References to Results 

Mathematica's input and output cells are automatically numbered in the order of their 
evaluation (In[ ... ], Out[ ... D. The expression %n is a short form for the output cell with the 

number n (i.e.: Out[n]). % indicates the last output cell, %% indicates the one before the 

last, etc. 

In[19):= 2% 

Out[19)= 2 f 

In[20):= % * %17 

Out[20)= 2bf 

• The Order of Evaluation 

The order of evaluation does not need to be from top to bottom; cells may also be evalu­

ated several times. In this case, however, once the notebook has been saved and evaluated 

in a new kernel, the results can be different if the order of definitions (see Section 1.4.4) 

has changed or if references to output cells are no longer correct. 

• Suppressing or Shortening the Output 

If you add ; to the end of an expression, Mathematica suppresses the display of the 

output. It gets evaluated nonetheless: 
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In[21]:= a A 2; 

In[22]:= % 

Out[22]= a 2 

This is useful for calculations with huge results where the formatting of an output of 

several pages takes a lot of time. Shortened results can be created with Short or Shal­

low. 

In[23]:= Expand [ (a + b + c) A 100]; 

In[24]:= Short [%] 

Out[24]IIShort= 

a lOO + 100 a 99 b + «5147» + 100 b C 99 + C100 

• In Depth 

• Notations 

In addition to standard notation 

In[25]:= Expand[(a+b) "2] 

Out[25]= a 2 + 2 a b + b 2 

functions with one argument can be written in a prefix notation using @ 

In[26]:= Expand @ «a + b) "2) 

Out[261= a 2 + 2 a b + b 2 

or in a POStfIX notation using / / 

In[27]:= (a+b) "2 II Expand 

Out[27]= a 2 + 2 a b + b 2 

For functions with two arguments you can also use infIX notation: 

In[28]:= {a, b} -Join- {c, d} 

Out[28]= {a, b, c, d} 

• 1.4.2 Numerical Calculations 

The operators for addition (+), subtraction ( - ), multiplication (*), division (!), and powers 

(A) are the usual ones. The multiplication asterisk can also be replaced by a space. 
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In[29):= 2 3 / 5 

Out[29)= 
6 
5 

Part 1 

Mathematica works with exact integers or rational numbers, as long as there is no decimal 

point. 

In[30):= 2" 100 

Out[30)= 1267650600228229401496703205376 

In[31):= 2.0" 100 

Out[31)= 1.26765 x 10 30 

In[32):= -Y"2 

Out[32)= Vi 

The conversion to approximate numbers is done by the function N. 

In[33):= N [-Y"2] 

Out[33)= 1.41421 

An optional second argument demands greater precision. 

In[34):= N [ -{2 I 50] 

Out[34)= 1.4142135623730950488016887242096980785696718753769 

Mathematica also recognizes various constants, e.g.: 

E or e: e "" 2.71828 
pi or IT: 

lor i: 

Degree: 

7f "" 3.14159 
i=-{~ 
7f / 180, the number of radians in one degree 

As long as a numerical approximation is not requested, these constants are used as purely 

symbolic expressions. Certain properties are (exactly) known. 

7f 
In[35):= 

4 

Out[35)= 
7T 

'4 
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In[36]:= 

Oul[36]= 

11" 
Sin[ --] 

4 

1 

-12 

In[37]:= N[Pi/4, 20] 

Oul[37]= 0.78539816339744830962 

In[38]:= Sin [45 Degree] 

1 
Oul[38]= 

-12 

43 

The many built-in mathematical functions and constants can best be found in the Help 

Browser (under Built-in Functions> Elementary Functions) or in the BasicCalcula­
tions palette. Their numerical evaluation is simple: 

In[39]:= ArcCos [0] 

JT 
OUI[39]= 2" 

In[40]:= ArcCos [7/10] 

Oul[40]= ArcCos [ 170 1 

In[41]:= N[%] 

Oul[41]= 0.795399 

In[42]:= ArcCos [ .7] 

Oul[42]= 0.795399 

• Exercises 

• The Exponential Constant 

Have a look at the first 1000 places of e. 

• Approximations 

Determine the absolute and the relative error of the approximation of 7r by the square root of 10. 
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• 1.4.3 Algebraic Manipulation 

Mathematica can also handle symbols. 

In[43]:= (a + b) "10 

Out[43]= (a + b) 10 

Only the simplest calculations are carried out automatically. All others must be requested 

specifically, since the program cannot know what we want to do with a formula. 

To expand out the above polynomial we can use several methods. We can find the applica­

ble function Expand in the Help Browser (Built-in Functions > Algebraic Manipula­

tion > Basic Algebra) and type it into the notebook. The % sign is used to reference the 

last output. 

In[44]:= Expand [%] 

Out[44]= a 10 + 10 a 9 b + 45 a 8 b 2 + 120 a 7 b 3 + 210 a 6 b 4 + 

252 as b S + 210 a 4 b 6 + 120 a 3 b 7 + 45 a 2 b 8 + 10 a b 9 + b 10 

Or we make a copy of (a + b) A 1 0, select it, and use the palette BasicCalculations > 
Algebra > Polynomial Manipulations to click Expand [_] into the notebook. The 

placeholder _ will automatically be replaced by the selection. 

In[45]:= Expand[(a+b) "10] 

Out[45]= a 10 + 10 a 9 b + 45 a 8 b 2 + 120 a 7 b 3 + 210 a 6 b 4 + 

252 as b S + 210 a 4 b 6 + 120 a 3 b 7 + 45 a 2 b 8 + 10 a b 9 + b 10 

As an alternative we can also select the formula and apply the function Expand [_] from 

the palette AlgebraicManipulation. The cell is evaluated "on location" and 

(a+b)"10 

changes into: 

aiD + 10 a 9 b + 45 as b 2 + 120 a 7 b 3 + 210 a 6 b' + 

252 as b S + 210 a' b 6 + 120 a 3 b 7 + 45 a 2 b S + 10 a b 9 + biD 

Try this yourself. 

One of the most favorite functions is Simplify. When we apply it to the above 

expanded polynomial, Mathematica returns it in its factored form, which clearly is much 

simpler. 
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In[47):= Simplify[a10 + 10 a 9 b + 45 a l b 2 + 120 a' b 3 + 210 a 6 b' + 

252 a 5 b 5 + 210 a' b 6 + 120 a 3 b' + 45 a 2 b l + 10 a b 9 + b 10 ] 

Out[47)= (a + b) 10 

In this case, Factor produces the same result. 

In[48]:= Factor[a10 + 10 a 9 b + 45 a l b 2 + 120 a' b 3 + 210 a 6 b' + 

252 a 5 b 5 + 210 a' b 6 + 120 a 3 b' + 45 a 2 b l + 10 a b 9 + b 10 ] 

Out[48]= (a + b) 10 

45 

The function FullSimplify often takes longer than Simplify, but it recognizes 

additional (and sometimes quite exotic) rules: 

In[49]:= Simplify [ArCCOS [ ~] ] 

Out[49]= ArcCos [~l 

In[50]:= FullSimplify [ArCCOS [~] ] 

Out[50]= ArcSin [Yx 1 

The simplification of formulas is a difficult problem which (in general) must be 

approached heuristically. The difficulties already start with the concept. Which of the 

following formulas is simpler? 

1- X 11 

In[51]:= FullSimplify [ ] 
i-x 

Out[51]= 
1 - Xll 

l-x 

Out[52]= 1 + x (1 + x (1 + x + x 2 ) (1 + x 3 + x 6 ) ) 

It is debatable. We therefore will not hold it against Mathematica for not using the same 

form in both cases, although they seem to be identical. 

In[53]:= Simplify[% - %%] 

Out[53]= 0 

(Are they really the same?) 
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• Exercises 

• A Simplification 

Use the appropriate function from the Basic Calculations palette (or type the name of the function) 

to simplify the following expression: 

as + 5 a' Cos [Xj2 + 10 a 3 Cos [xj' + 10 a 2 COS [X]6 + 

5 a Cos [xj8 + Cos [xj l0 + 5 a' Sin [X]2 + 20 a 3 COS [X]2 Sin[xj 2 + 

30 a 2 Cos [x]' Sin [xj2 + 20 a COS [X]6 Sin [X]2 + 5 Cos [xj8 Sin [X]2 + 

10 a 3 Sin[x]' + 30 a 2 COS[X]2 Sin[x]' + 30 aCos[xj' Sin[xj' + 

10 Cos [xj 6 Sin [xj' + 10 a 2 Sin[xj 6 + 20 a Cos [xj 2 Sin [xj 6 + 

10 Cos [xj' Sin [x]6 + 5 a Sin [X]8 + 5 Cos [x]2 Sin [X]8 + Sin [X]lO 

• Calculating "on Location" 

Use the AlgebraicManipulation palette to: 
• expand out (a + b) 10, 

• factor the result, 
• simplify Sin [20:+(3] Cos [20:+(3] , 

• simplify Log [z + v:;:;l ~ 1 
(compare the results of Simplify and FullSimplify). 

• Self Study 

Take a look at Section 1.4.5 in the Mathematica Book. 

• Goniometric Relationships 

Convert the formula 

Sin[3 xj Cos [5 x] 

into a form in which no multiples of x appear in the trigonometric functions. 

• 1.4.4 Transformation Rules and Definitions 

This section will be difficult on first reading. Read it through first and return to it later on, 

whenever the use of transformation rules or definitions is unclear to you. 

• Transformation Rules 

Replacing values for symbols is done by the operator / . in which a transformation rule 

has to be given on the right-hand side. The latter is written in InputForm as variable -> 

value or in StandardForm as variable -7 value. 
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In[541:~ Sqrt[a+b"'2] /.a->2 

Out[541~ ~ 

In[551:~ ~ /. b -+ 3 

Out[551~ ~ 

Several simple rules can be combined in a list. 

In[561:~ ~ /. {a -+ 3, b -+ 7} 

Out[561~ 2 m 
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We also call such a list transformation rule because it acts like a single transformation 

rule-unlike a nested list. Nested lists allow us to substitute different values at the same 

time. 

In[571:~ ~ /. {{a-+c, b-+O}, {a-+a2 }} 

Out[571~ {rc, ya2 + b 2 } 

• Simple Definitions 

An immediate definition is indicated by an equals sign (=). 

In[581:~ al = 1 

Out[581~ 1 

The right-hand side of the immediate definition is evaluated when the definition is evalu­

ated: You can see the result in the output cell. During the Mathematica session, the 

definition is applied whenever the left -hand side of the definition matches a subexpression. 

In[591:~ al + a2 

Out[591~ 1 + a2 

In[601:~ a2 = al 

Out[601~ 1 

In[611:~ a2 

Out[611~ 1 



48 Part 1 

Delayed definitions (: =) are also used wherever their left-hand side appears. But in this 

case the evaluation of the right-hand side is delayed until the definition is used. Therefore 

we do not get an output cell. 

In[62]:= a3: = al 

In[63]:= a3 

Out[63]= 1 

If we change the value of al and evaluate a3 again, we get a different result. 

In[64]:= al = 3 

Out[64]= 3 

In[65]:= a3 

Out[65]= 3 

The value of a2, which was set with an immediate definition, has not changed. 

In[66]:= a2 

Out[66]= 1 

We can look at the definitions associated to name by evaluating ? name. 

In[67]:= ? a3 

Global'a3 

a3 := al 

This shows us that a3 is in the context Global' (see Section 4.4.5) and that the defini­

tion a3 : =al has been set for it. 

• Clearing Definitions 

Immediate and delayed definitions are cleared with Clear or = .. 

In[68]:= Clear [a2, a3] 

In[69]:= {al, a2, a3} 

Out[69]= {3, a2, a3} 
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In[70]:= al = • 

In[71]:= {al, a2, a3} 

Oul[71]= {al, a2, a3} 

• Simple Patterns 

The left-hand side of transformation rules and definitions are actually patterns. Up to now, 

they have been very simple, because they contained only single symbol names. But 

wherever there is a blank C , ~- on the keyboard) in a pattern any expression can appear 

in its place. Therefore the blank symbol "_" stands for "anything". 

In[72]:= 1 + a A 2 / • _ A 2 - > somethingSquared 

Oul[72]= 1 + something Squared 

In definitions we usually need this "anything" on the right-hand side. It can therefore be 

associated with a name. So x_ stands for any given number, symbol, or more general 

expression which will be referenced by the name x on the right-hand side. We can use this 

to define functions: 

In[73]:= functionl [x_l = Sin [1 / xl 

Oul[73]= Sin [ ~ 1 

In[74]:= functionl [31 

OUI[74]= Sin [ ~ 1 

In[75]:= functionl [f [Tan [alll 

OUI[75]= Sin[ f[Ta~[alll 

In this example a delayed definition would have given the same result. But if something 

needs to be evaluated on the right, then it makes a difference what type of definition it is. 

Look at the two following definitions: 

In[76]:= myExpandl [x_l = Expand [ (1 + x) A 21 

OUI[76]= 1 + 2 x + x 2 

In[77]:= myExpand2 [x_l : = Expand [ (1 + x) A 21 
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When applied to a single symbol or a number they give the same result. 

In[78):= myExpandl [a] 

Out[78)= 1 + 2 a + a 2 

In[79):= myExpand2 [a] 

Out[79)= 1 + 2 a + a 2 

But if we evaluate them for a sum, this sum is simply substituted for x in the first version. 

In[80):= myExpandl [a + b] 

Out[80)= 1 + 2 (a + b) + (a + b) 2 

On the other hand, with a delayed definition the sum is substituted and the Expand of the 

resulting expression is then calculated. 

In[81):= myExpand2 [a + b] 

Out[81)= 1 + 2 a + a 2 + 2 b + 2 a b + b 2 

• Rules of Thumb for Definitions 

We can keep to the rule of thumb that immediate definitions serve as shortcuts for fixed 

values of symbols or patterns. But if something needs to be calculated when the definition 
is used, then a delayed definition is appropriate. 

Because definitions are valid throughout a Mathematica session if they are not cleared by 

hand, they can lead to confusion if you are working on a larger project and forget them. 

Transformation rules are therefore more suitable for substituting values. 

• In Depth 

• Clearing All Definitions 

This clears all definitions without launching a new kernel session (see Section 4.4.5): 

In[82):= Clear [Global' * 1 

• Compound Expressions 

If needed, we can combine several expressions on one line or in one cell by separating them with 

semicolons. This is called a compound expression. 
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In[83]:= consti = .2; const2 = .3; {consti, const2} 

QUI[83]= {D.2, D.3} 

• Exercises 

• Substituting Values 

In the following expression, fust have a=2, then b=3 (with any value for a), and then at the same 
time have a=2 and b=3. 

• A Function Definition 

Define a function with two arguments n and x, which calculates sin(nx). 

• Stirling's Formula 

For large n Stirling's formula is valid: log n! '" (n + +) log n - n + log -.[2;(. 

Calculate the absolute and the relative errors for n = 2, 10, 100. First use transformation rules and 

then definitions. 

• 1.4.5 Equations 

• Single Equations 

Equations (and differential equations) are indicated in Mathematica with a double equals 
sign, since the simple equals sign is already taken by definitions. 

In[84]:= a x + b == 1 

Qul[84]= b + a x == 1 

In[85]:= myEquation = a x + b == 1 

Qul[85]= b + a x == 1 

The Mathematica function for solving one or more equations is called Solve. It needs to 

know the equation and the variable. 

In[86]:= Solve [a x + b == 1, xl 

{{X ~_-la+b}} Qul[86]= ~ 
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In[87):= Solve [myEquation, x] 

{ {x --) - -1a+ b }} Out[87)= 

Let us give the solution a name: 

In[88):= result = % 

{ {x --) _ -1a+ b }} Out[88)= 

Part 1 

The result of So 1 ve is written as a list of transformation rules, which may be irritating at 

first. In addition, it is a nested list, because we can also solve sets of equations with several 

solutions and several unknowns. We get the first (and in this case only) solution by 

accessing the first (and only) element of the list: 

In[89):= first Solution = result [[1]] 

Out[89)= { -1+b} 
x--) ---­

a 

This is a transformation rule which we can apply to expressions. We substitute the solution 

for x into the equation with: 

In[90):= myEquation /. firstSolution 

Out[90)= True 

The answer to the frequently asked question, how to set x to this value definitively, is: 

In[9t):= x = x /. firstSolution 

Out[91)= 
-1 + b 

a 

In[92):= x + 1 

-1 + b 
Out[92)= 1 - --a-

or in one step: 
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In[93]:= x = x /. Solve [a x + b == 1, xl [1] 

General: :ivar : - -1 +b is not a valid variable. 
a 

ReplaceAll: : reps : 
{True} is neither a list of replacement rules nor a valid 

dispatch table, and so cannot be used for replacing. 

-1 + b 
Out[93]= - --a- / . True 
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This already shows us the danger in this kind of definition: x already has a value through 

the definition x = x /. firstSolution. This is immediately substituted into the equation 

which evaluates to True. The name x can therefore no longer be used as a variable. It is 

better if we delete the definition for now 

In[94]:= x = • 

and avoid the definition for x: 

In[95]:= x / • Solve [a x + b == 1, xl [1] 

Out[95]= 
-1 + b 

a 

Nonlinear equations are more interesting: 

In[96]:= threeSolutions = Solve [XA 3 + X A 2 - x + 1 == 0, xl 

1 4 1 -[33 113 
Out[96]= {{X-7- 3 -

3 (19_3-[33)113 
-3 (19-333) }, 

1 2 (1+1-)3) 1 
(1-1-)3) -[33 113 {X-7- 3 + 

3 (19_3-[33)113 
+ - (19-3 33) }, 

6 

1 2 (1 - 1-)3) 1 
(1 + I -)3) -[33 113 {X-7- 3 + 

3 (19_3-[33)113 
+ - (19-333) }} 

6 

This gives us three solutions. The list of transformation rules can be applied as a whole to 

an expression. The result is the list of the three substitutions. 
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In[97]:= x / • threeSolutions 

{- ~ -
4 1 -{33 1/3 

Out[97]= -{33 1/3 -3(19-333) , 
3(19-333) 

1 2 (l+I-{3) 1 
(l-I-{3) -{33 1/3 

-3 + -{33 1/3 +"6 (19-3 33) , 
3(19-333) 

1 2 (l-I-{3) 1 
(1 + I-{3) 

-{33 1/3 
-3+ -{33 1/3 + - (19-333) } 

3(19-333) 6 

Let us verify the solution. 

In[98]:= Simplify[x" 3 + x" 2 - x + 1 == 0 /. threeSolutions] 

$MaxExtraPrecision: :meprec : 
In increasing internal precision while attempting to evaluate 

4 4 1 
-3 + 1/3 + -3 (<<1») 1/3 + (<<1») 2 + (<<1») 3, the 

3 (<<1») 
limit $MaxExtraPrecision = 50.' was reached. Increasing the 
value of $MaxExtraPrecision may help resolve the uncertainty. 

$MaxExtraPrecision: :meprec : 
In increasing internal precision while attempting to evaluate 

.!_ 2(1+I~; _«1»+(<<1»)2+(<<1»)3, the limit 
3 3 (<<1») 
$MaxExtraPrecision = 50.' was reached. Increasing the value 
of $MaxExtraPrecision may help resolve the uncertainty. 

$MaxExtraPrecision::meprec: 
In increasing internal precision while attempting to evaluate 

4 2 (1-I-{3) 
- - 1/3 - «1» + (<<1») 2 + (<<1») 3, the limit 
3 3 (<<1») 
$MaxExtraPrecision = 50.' was reached. Increasing the value 
of $MaxExtraPrecision may help resolve the uncertainty. 

General: : stop : 
Further output of $MaxExtraPrecision: :meprec will be 

suppressed during this calculation. 

Out[98]= { True, True, True} 

Part 1 

The result is correct; the messages (produced by Version 3.0.1) should not appear. Like 

every nontrivial program, Mathematica is not perfect. Just to double check we will try an 

alternate version, where we only calculate the left -hand side of the equation. 

In[99]:= Simplify [x" 3 + x" 2 - x + 1 / • threeSolutions] 

Out[99]= {O, 0, O} 
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• Sets of Equations 

In order to solve a set of simultaneous equations, we group the equations and the 
unknowns as lists. 

In[100]:= Solve[{2x2 +y==l, x-y==2}, {x, y}] 

Out[100]= 

We thereby finally recognize the meaning of the display of solutions as nested lists. We 

have a list with two solutions and each solution is a list of rules for the two unknowns. 

In[101]:= Simplify [ {2 x 2 + y == 1, x - y == 2} /. %] 

Out[101]= {{ True, True}, {True, True}} 

The Eliminate function is sometimes also useful. It eliminates variables from a set of 

equations. 

In[102]:= Eliminate [{x - y == d, x + y == s}, x] 

Out[102]= d == s - 2 Y 

• Numerical Solutions of Polynomial Equations 

The solutions of polynomial equations of degree > 4 can generally not be written as 

rational expressions with radicals. 

In[103]:= Solve[x5 - x 2 + 1 == 0, x] 

Out[103]= {{ x ~ Ro 0 t [1 - # 1 2 + # 1 5 &, 1]}, 

{x~Root[1-#12 +#1 5 &, 2]}, {x~Root[1-#12 +#1 5 &, 3]}, 

{x~Root[1-#12 +#1 5 &, 4]}, {x~Root[1-#12 +#1 5 &, 5]}} 

We do not want to get further into Root objects (with which you can also calculate), 

rather we want to create a numerical approximation of the solutions. 

In[104]:= N [%] 

Out[104]= {{ x ~ - 0 . 808731 }, {x ~ - 0 . 464912 - 1. 07147 I}, 
{x~ -0.464912 + 1.07147 I}, 

{x~0.869278-0.388269I}, {x~0.869278+0.388269I}} 

Aside from numeric subtleties, the function NSol ve gives us the same result as 

N[Solve[ ... JJ 
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In[105):= NSolve[x5 - x 2 + 1 == 0, x] 

Out[105)= {{x ~ -0. 808731}, {x ~ -0.464912 - 1. 07147 I}, 
{x ~ -0.464912 + 1.07147 I}, 
{x~ 0.869278 - 0.388269 I}, {x~ 0.869278 + 0.388269 I}} 

• Numerical Solutions of Transcendental Equations 

Part 1 

Unfortunately, there are also transcendental equations which can possibly have several or 

an infinite number of solutions. 

In[106):= Solve [Log [x] == Cot [x], x] 

Solve: : tdep : 
The equations appear to involve transcendental functions 

of the variables in an essentially non-algebraic way. 

Out[106)= Solve [Log [xl == Cot [xl, xl 

With a look ahead at Part 2, let us create at a plot of both sides of the equation. 

In[107):= Plot[{Log[x], Cot[x]}, {x, 0, 4n}] 

20 

10 

\. \ 
2\ 4 8 '\ 10 

-10 

-20 

Out[107)= • Graphics· 

This shows us that there are (infinitely) many solutions. We can only use a numerical 

algorithm to search an approximation of one solution (see also Section 4.4.2). The function 

that does this for us, FindRoot, demands that the equation (or the expression whose 

roots are being sought) be the first argument and that a list with the variable and the initial 

value be the second. 

In[108):= FindRoot [Log[x] == Cot [x], {x, 1}] 

Out[108)= {x ~ 1. 30828} 
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A different initial value may deliver a different solution. 

In[109):= FindRoot [Log [xl == Cot [xl, {x, 7} 1 

Out[109)= {x ~ 6.76512} 

Note that the solution found by the numerical algorithm does not need to be the closest to 

the starting value. Here we use expressions instead of equations. 

In[110):= FindRoot [x'" - 2 x" 2 + 1 / 2, {x, .i} 1 

Out[110)= {x ~ 1. 30656} 

In[111):= FindRoot[x"'-2x"2+i/2, {x, .2}l 

Out[111)= {x~0.541196} 

You can find further ways of calling up FindRoot in the Help Browser . 

• In Depth 

• Special Cases 

Let us look at the solution of ax = 1. 

In[112):= Solve[ax == b, x] 

Out[112)= 

Obviously, if b *- 0, the solution is not valid for a = O. 

In[113):= %[ [1]] I. a -> 0 

Power: : infy: Infinite expression 1 encountered. o 
Out[113)= {x --,) ComplexInfinity} 

We see here, that the function Solve does not take special cases into consideration. Technically 

speaking, it only delivers a generic solution. 

The Reduce function helps us further. It creates a logical expression containing all special cases. 

In[114):= Reduce[ax==b, x] 

b 
Out[114)= b == 0 && a == 0 I I a"* 0 && x == a 

The logical or is written I I, the logical and as &&, and unequal as *" or ! = . 
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• Inequalities 

The Inequal i tySol ve function is defined in the Algebra' Inequal i tySol ve' package. It 

helps us simplify inequalities. To use it we must first load the package. 

In[115]:= «Algebra' :InequalitySolve' 

Now we can simplify the following inequality, for example: 

In[116]:= :InequalitySolve[x A 2 - 3> 0, xl 

Out[116]= x < - -[3 I I x > -[3 

Hence, x must satisfy either x < -...[3 or x > ...[3 . 

• Exercises 

• Quadratic Equations 

Solve the quadratic equation a x2 + b x + c = 0 for x. 

Verify the result by substituting it into the equation. 

Define a variable with the name solution!, whose value is the first solution of the equation. 

Find a form of the solution that also takes special cases like a = 0 into account. 

• Equations of Higher Degree 

Study the symbolic solutions to the equation: 

4 X4 + 3 x 3 + :I x 2 + X + 1 == 0 

Create numerical approximations of the solutions using different methods. 

• Transcendental Equations 

Find the first two positive points of intersections of e-x and sin(x). 

• Sets of Simultaneous Equations 

Solve the following set and verify the solutions by substituting them into the equations. 

{x2 + Y == 1, 3 Y - x == a} 

• Elimination of Variables 

Eliminate x and y from the following set of simultaneous equations: 

{x2 +y+z==l, 3y-x==a, x+2z==0} 

• Inequalities 

Determine where the inequalities Ix2 - 31- 2 > 0 and ~ - x3 > 0 hold (separately and simulta­

neously). 
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• 1.4.6 Calculus 

• Limits 

Limits are determined with the function Limi t as follows: 

In[117):= Limit[(x-1)A21 (xA2-1), x->l] 

Out[117)= 0 

(x _ 1) 2 

In[118):= Limit [ , x-+ -1] 
x 2 - 1 

Out[118)= 

We see that the symbol Inf ini ty or 00 is predefined. We can use it for limits or inte­

grals, among other things. 

In[119):= Limit [Log [x] Ix, x -> Infinity] 

Out[119)= 0 

2 

For the above expression (:;~i the limits are different if x approaches -1 from smaller 

values or from larger values. 

(x _ 1) 2 

In[120):= Plot [ , {x, -2, 2}] 
x 2 - 1 

100 

50 

-2 1 2 

-50 

-100 

Out[120)= - Graphics -

The option Direction can be used to differentiate between the limit from the left 

(Direction--71) and the limit from the right (Direction--7-1). 
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(x _ 1) 2 

In[121]:= Limit [ , x .... -1, Direction .... 1] 
X2 -1 

Out[121]= 00 

(x _ 1) 2 

In[122]:= Limit [ , x .... -1, Direction .... -1 ] 
x 2 -1 

Out[122]= 

Many other Mathematica functions can be manipulated in an analog way using options. 

These are always written as transformation rules. In Part 2 we will see many further 

examples with graphic functions. 

• Derivatives 

We have already seen the function D for the calculation of derivatives. Because it is used 

often, its name is (like N) one of the few exceptions in naming where only a letter is used 
in place of a whole word. 

In InputForm the expression to be derived comes first, then the variable or a list contain­

ing the variable and the multiplicity of the derivative. 

In[123]:= D [x A 2, x] 

Out[123]= 2 x 

In[124]:= D [Sin [x], {x, 2}] 

Out[124]= -Sin [xl 

In StandardForm (see palette BasicCalculations > Calculus> Common Operations) 
the input cells are written a little differently: 

Out[125]= 2 x 

In[126]:= "{X.2} Sin [x] 

Out[126]= -Sin [xl 

Let us calculate the derivative of an unknown function. 
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In[127):= D [f [xl, xl 

Out[127)= f' [xl 

Apostrophes may also be used to enter derivatives of functions of one variable. This is 

particularly useful for differential equations. Mathematica treats both variations identically. 

In[12B]:= f I [xl - % 

Out[12B]= 0 

• Integrals 

We use the function name Integrate (in InputForm) or the palette BasicCaicula­

tions > Calculus> Common Operations for calculating integrals. 

In[129]:= Integrate [x Sin [xl, xl 

Out[129]= -x Cos [xl + Sin [xl 

In[130]:= f x Cos [xl clIx 

Out[130]= Cos [xl + x Sin [xl 

Mathematica sets the constant of integration in indefinite integrals to zero. 

As you have probably been starting to guess, the variable and the end points of a definite 

integral must be given as a list. 

In[131]:= Integrate [x Log [xl, {x, a, b} 1 

1 1 
Out[131]= -"4a2 (-1+2Log[al) +"4b2 (-1+2Log[bl) 

The entry is even easier using the palette. Click on the template 

and jump from placeholder to placeholder using the tab key. This gives us for example: 

In[132]:= 121r (a - a Cos [t]) 2 clIt 

Out[132]= 3 a 2 If 
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Integrals of expressions with elementary functions are-unlike their derivatives-often no 

longer elementary. Either the results are special functions that are basically defined as 

being the integral of another function 

In[133]:= f Exp [X2 ] dlx 

Out[133]= ; -{iT Erfi [x] 

or the integral is returned unevaluated: 

In[134]:= 12 Exp [x2] Log [x2] Sin [x2] dlx 

Mathematica does not calculate integrals in the same way you learned in school. The 

Risch algorithm implemented in the program can calculate an entire class of integrals and 

can also decide whether the result exists as a function in this class. In addition, Mathemat­

ica recognizes many definite integrals which can be written as hypergeometric or other 

special functions. 

The function NIn tegra te returns numerical approximations of definite integrals. 

In[135]:= NIntegrate [Exp [x2 ] Log [x2 ] Sin [x2 ], {x, 1, 2}] 

Out[135]= -2.22919 

• Differential Equations 

Analogous to algebraic equations, differential equations are also written using ==. The 

functional dependence of variables must be indicated explicitly. Derivatives are usually 

written using the form x' [t] instead of D [x [ t] , t] . 

In[136]:= x" [t] + x[t] == 0 

Out[136]= x[t] +x" [t] == 0 

We get the solution with DSol ve, where the unknown function and the independent 

variable are given as second and third argument. 

In[137]:= DSolve[x" [t] +x[t] == 0, x[t], t] 

Out[137]= {{x[t] ~C[2] Cos[t]-C[l] Sin[t]}} 
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The constants C [1] and C [2] must be determined from the initial conditions. If these are 

already known, we write the differential equation together with the initial conditions as a 

set of equations. 

In[138]:= DSolve[{x' I [t] +x[t] == 0, x[O] == 1, X' [0] == O}, x[t], t] 

Out[138]= {{ x [ t 1 --) Cos [t 1 } } 

As with algebraic equations, we can get the resulting functions as follows: 

In[139]:= x[t] /. %[[1]] 

Out[139]= Cos [t 1 

Differential equations are also seldom solvable in closed form. 

In[140]:= DSolve[x' I [t] +Sin[x[t]] == 0, x, t] 

Solve: :verif : 
Potential solution {x[t] ~ComplexInfinity} cannot be verified 

automatically. Verification may require use of limits. 

Solve: :ifun: Inverse functions are being 
used by Solve, so some solutions may not be found. 

Solve: :verif : 
Potential solution {x[t] ~ComplexInfinity} cannot be verified 

automatically. Verification may require use of limits. 

Solve: :ifun: Inverse functions are being 
used by Solve, so some solutions may not be found. 

Solve: :verif : 
Potential solution {x[t] ~ComplexInfinity} cannot be verified 

automatically. Verification may require use of limits. 

General: :stop : Further output of 
Solve: :verif will be suppressed during this calculation. 

Solve: :ifun: Inverse functions are being 
used by Solve, so some solutions may not be found. 

General: :stop : Further output of 
Solve: :ifun will be suppressed during this calculation. 

Out[140]= DSolve[Sin[x[t]] +x" [t] == 0, x, t] 

In such cases we have to resort to NDSo 1 ve which gives us at least a numerical solution. 
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In[141):= NDSo1ve[{x" [t] +Sin[x[t]] == 0, x[O] == 1, x' [0] == O}, 
x[t], {t, 0, 10}] 

Out[141)= {{x[t] ~InterpolatingFunction[{{D., 1D.}}, <>] [t]}} 

The resulting numerical function can be extracted as usual: 

In[142):= x [t] /. % [ [1] ] 

Out[142)= InterpolatingFunction[{{D., 1D.}}, <>] [t] 

and evaluated 

In[143):= % /. t -> 1.5 

Out[143)= D .166936 

or, as we will see in Part 2, plotted. 

In[144):= P1ot[%%, {t, 0, lOll 

Out[144)= - Graphics -

• In Depth 

• Solutions of Differential Equations as Pure Functions 

Part 1 

It is often more practical to request the solution of a differential equation as transformation rule for x 

itself. 

In[145):= DSo1ve[ {x I I [t] + x[t] == 0, x[O] == 1, x '[0] == O}, x, t] 

Out[145)= { {x --> (Cos [#1] &) } } 

This creates a so-called pure function (see Section 3.2.3), which can be evaluated exactly as above 
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In[146]:= x[t] /.%[[1]] 

Out[146]= Cos [t] 

Pure functions help us to verify the solution. 

In[147]:= {x" [t] + x[t] == 0, x[O] == 1, x' [0] == O} /. %%[ [1]] 

Out[147]= {True, True, True} 

• Exercises 

• Limits 
1 

Calculate the limits of T~ as x approaches 0 from the left and from the right. 

• Derivatives 

Calculate the derivative of x<X . 

Did you derive x~ (x~x) or (x~x) ~x? Is there a difference? 

Calculate the second derivative of sin(f(t)) cos(f(t)) with respect to t, when J(t) is any function of t. 

• Integrals 

Note the following expression: 

Exp[-x] sin[x]2 

Calculate the indefinite integral and the definite integrals in the intervals [-1, 1] and [0, 00 ). 

Use also the numerical function Nlntegra te to determine both definite integrals. How well do the 

symbolic and numerical results agree? 

• Differential Equations 

Solve the differential equation system {x(t) + x' (t) = y(t), x(t) + y' (t) = I} and simplify the result. 

(The documentation of DSol ve explains how to solve sets of differential equations.) 



Part 2: Graphics 

Graphics are an eye-catching, attractive element of Mathematica. This part deals with the 

different methods of producing and refining plots of functions or data and with the export 

of graphics to other programs. 

S. Kaufmann, A Crash Course in  Mathematica
© Birkhäuser Verlag 1999
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.2.1 Graphs of Functions of One Variable 

First a word about the terminology: The term graph has a mathematical definition as a set. 

A computer program can only visualize a finite part of this-possibly infinite-set. Further­
more, we often use axes, headings, etc. to expand on the information. The resulting object 

will still be called a "graph". Mathematica can also create graphics which are not graphs. 

In our terminology a "graph" is a special kind of "graphic". 

When visualizing mathematical functions and mappings it is important to consider the 
dimensions of the domain and of the range. This immediately leads to the appropriate 

Mathematica function. The palette BasicCalculations > Graphics contains templates for 

the common cases. 

We start by plotting graphs of functions R ~ R. 

First we create the graph of the function x ~ sin(x) over a period using Plot. 

In[1]:= Plot [Sin [xl I {x, 0 I 2 pi} 1 

1 

2 4 5 6 

-0.5 

-1 

Out[1]= - Graphics -

Since we are mainly interested in the graphics themselves, we will suppress the output 

cells using a semicolon. 

We can also plot several functions at once by passing a list. 
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In[2]:= Plot[{Sin[x], Sin[2x], Sin[3x]}, {x, 0, 27T}]; 

Naturally the function can also first be defined and then plotted. 

In[3]:= functionl [x_] = 
Sin [x] 

x 

In[4]:= Plot[functionl[x], {x, 0, 2 7T} ] ; 

1 

0.8 

0.6 

0.4 

0.2 

1 2 3 4 5 

-0.2 

The above definition was written using an immediate definition, since this is just a short­
cut and the right-hand side of the definition does not need to be evaluated every time it is 

called up. A delayed definition produces the same result by evaluating the function 

definition for every point of the plot. For large calculations, the CPU times of these two 

variants can differ significantly-but either one can be faster (see the exercise "Efficiency"). 

Sin [x] 
In[5]:= function2 [x_] : = ---

x 
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In[6]:= Plot [function2 [x], {x, 0, 2 JT} ] ; 

1 

0.8 

0.6 

0.4 

0.2 

-0.2 

1 2 3 

Part 2 

We can change the appearance of graphics in various ways using options. The options are 

set as transformation rules of the form name -> value. The documentation on Plot in 

the Help Browser lists the specific options of Plot (Compiled etc.). It tells us that all 

options of Graphics objects can be used as well. In the documentation on Graphics 

we find a long list of options (from AspectRatio to Ticks) with their default values. 

Each option again has a documentation of its own. 

Let us take a look at some of the most-used options, with which we can edit our graphic. 

An immediate definition gives it a name for later reference: 

In[7]:= demoPlot=Plot[x A 2Sin[1/x], {x, -JT, JT}]; 

-1 1 

As we can see, the range in this case is automatically limited by Mathematica. To clearly 

display the linear behavior of this function at large arguments, we use PlotRange­

> All. This plots all values. 



Graphics 

1 
In[8]:= P1ot[x2 Sin[-], {x, -71:, 7I:}, PlotRange->All]; 

x 

3 

2 

1 

-3 -2 -1 1 2 3 

-1 

-2 

-3 

71 

The option value AspectRatio->Automatic scales both axes identically. We can 

add a value for ImageSize to get a graphic of a given size. 

In[9]:= Show[%, AspectRatio -> Automatic, ImageSize -> 150]; 

3 

2 

1 

-3 -2 -1 123 

-1 

-2 

-3 

Instead of re-calculating the whole graphic after changing an option, it can also just be re­

drawn with the Show command and any changed options. 

AxesOrigin moves origin of the coordinate system. 
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In[10):= Show [demoPlot, AxesOrigin -+ {-I, O} 1 ; 

0.15 

0.1 

0.05 

1 
-0.05 

-0.1 

-0.15 

AxesLabellabels the axes using strings that must be placed in quotation marks. 

In[11):= Show [demoPlot, AxesOrigin -+ {-I, O}, 

AxesLabel -+ {"x", "x2 Sin [xl"} 1 ; 

x 2 Sin [x] 

0.15 

0.1 

0.05 

1 x 

-0.05 

-0.1 

-0.15 

PlotLabel adds a title. 

In[12):= Show [demoPlot, AxesOrigin -+ {-I, O}, 

PlotLabel -+ "Plot of x 2 Sin [xl n 1 ; 

0.15 

0.1 

0.05 

-0.05 

-0.1 

-0.15 

Plot of x 2 Sin [x] 

1 

Part 2 



Graphics 

• In Depth 

• Frames 

Frarne->True creates a frame around the graphic. 

In[13]:= Show[demoPlot, Frame -> True]; 

0.15 
0.1 

0.05 
O~------~~~~~~------~ 

-0.05 
-0.1 

-0.15 

-1 1 

Axes->False suppresses the axes. 

In[14]:= Show[demoPlot, Frame -> True, Axes -> False]; 

0.15 
0.1 

0.05 
o 

-0.05 
-0.1 

-0.15 

-1 

GridLines->Autornatic shows a grid. 

1 

In[15]:= Show[demoPlot, Frame -> True, GridLines -> Automatic]; 

0.15 
0.1 

0.05 
o 

-0.05 
-0.1 

-0.15 

-1 
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\/ 

o 0.5 1 

FrarneLabel creates a label for the axes (the vertical label appears vertically on the printout). 

73 
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In[16]:= Show[demoPlot, Frame-> True, FrameLabel-> {"X", "x2 Sin[x]"}]; 

0.15 
0.1 

~ 0.05 
~ 

0 ·rl 
Ul 

-0.05 
'" ~ -0.1 

-0.15 

-1 
x 

• Changing the Character Format 

The option TextStyle uses a list of sub-options with which we can change the format of the text. 

In[17]:= Show[demoPlot, TextStyle-> 
{FontFamily -> "Times", FontSlant -> "Italic", FontSize -> 9}]; 

-1 1 

If we want to change only the title: 

In[18]:= Show [demoPlot, AxesOrigin ... {-1, O}, 

PlotLabel ... StyleForm ["Plot of x 2 Sin [x] " , 
FontFamily -> "Times", FontSlant -> "Italic", FontSize -> 12]]; 

0.15 
0.1 

0.05 

-0.05 
-0.1 

-0.15 

Plot of x 2 Sin[x] 

StyleForm lets us use a pre-defined notebook style. 

1 
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In(19):= Show[demoPlot, AxesOrigin -+ {-1, O}, 

PlotLabel-+ StyleForul[ nplot of x 2 Sin [x] n, nSectionn]]; 

0.15 
0.1 

0.05 

-0.05 
-0.1 

-0.15 

Plot of x2 Sin[x] 

Or we can put a formula into the title. 

1 

In[20):= Show[demoPlot, AxesOrigin-+ {-1, OJ, 

PlotLabel-+ TraditionalForm[x2 Sin [x] ], 
TextStyle -> {FontFamily -> nTimes", FontSize -> 9}]; 

0.15 
0.1 

0.05 

-0.05 
-0.1 

-0.15 

• Changing Lines 

i sin(x) 

75 

The option PlotStyle can be used to change the thickness and color of lines and to draw dashed 
lines. Because this is an option of Plot and not of Graphics, displaying with Show will not work 

and the graph must be re-calculated. AbsoluteThickness sets the line thickness to the amount 

of pixels given. 

1 
In(21):= Plot [x2 Sin[ -], {x, -1f, 1f}, PlotStyle -> AbsoluteThickness[2J]; 

x 

-1 1 
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The option value Dashing defines dashed lines. Its argument determines the lengths of the 

segments. As with line thickness, there are two versions: those whose values are given as a fraction 
of the width of the graphic (Thickness, Dashing) and those which use an absolute number of 

pixels (AbsoluteThickness, AbsoluteDashing) . 

1 
In[22]:= Plot[x2 Sin[-J, {x, -7f, 7f}, PlotStyle-> Dashing[{.l, .02}]J; 

x 

0.15 
I 

I 0.1 

-1 -0.5 1 
;-0. 05 

-0.1 

; -0.15 

When several graphs are plotted, the functions are handled cyclically by PlotStyle. 

In[23]:= Plot[{Sin[x], Sin[2x], Sin[3x]}, {x, 0, 27f}, PlotStyle-> 
{Dashing[{.2, .02}], Dashing[{.l, .02}], Dashing[{.OS, .02}]}]; 

Colors can easily be defined with the function Hue, which represents the color circle at full bright­
ness and saturation when a single argument in the interval [0, 1] is given. 
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In[24]:= Plot [Evaluate [Table [x A n, {n, 0, 10} 1] , 
{x, 0, l}, PlotStyle-> Table[Hue[n/ll] , {n, 0, lOll, 
PlotRange -> All, AspectRatio -> Automatic] ; 

1r-----------------------~ 

0 . 8 
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0.2 0.4 0 . 6 0.8 1 
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In this calculation we used the functions Table to create a list and Evaluate to enforce the 
evaluation of the first argument before the Plot function itself. The latter is necessary because 

Plot only processes lists which are given explicitly . 

• Suppressing the Display of Graphics 

It is sometimes useful to suppress the display of a graphic. We can do this using the option Display­

Function->Identity. 

In[25]:= Show[demoPlot, DisplayFunction -> Identity] 

Out[25]= - Graphics -

DisplayFunction- >$DisplayFunction regenerates the display. ($DisplayFunction 

is a global variable.) 

In[26]:= Show[%, GridLines -> Automatic, DisplayFunction -> $DisplayFunction]; 

L / 
v •• ~ 

/ 
/ 

(\ 1\ / 
-1 -0 .5/ v 

\/ 0 5 

/ V~U~ 

/ 
u •• 

" L 

/ 
u •• ~ 



78 Part 2 

• Poles and Singularities 

The default option values of Plot produce reasonable plots even when there are poles or singulari-

ties. 

In[27]:= Plot[l/ (x-l), {x,-1,3}]; 

40 

20 

-1 2 3 

-20 

-40 

In[28]:= Plot[Sin[l/x] , {x, 0, .l} ] ; 

In this case the default value for PlotPoints should probably be increased, i.e. the number of 
function values calculated initially, before the algorithm refines the graph adaptively. 

In[29]:= Plot[Sin[l/x], {x, 0, .l}, PlotPoints-> 200]; 

• Superimposing Graphics 

Show can also be used to superimpose several graphics onto one another. 
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In[30]:= Plot [Exp[ -x], {x, 0, 2 Pi}] ; 

1 

0.2 

1 2 3 4 

In[31]:= Plot [Sin[x], {x, 0, 2 Pi}]; 

1 

-0.5 

-1 

5 6 

In[32]:= Plot[Sin[x] Exp[-x], {x, 0, 2Pi}]; 

1 2 6 

In[33]:= Show[%, %%, %%%] ; 

5 6 

-1 

79 
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In Section 2.4 we will look at additional helpful tools for designing graphics. 

• Exercises 

• Plotting Graphs 

Separately plot the graphs of the functions x -4 sinh(x), x -4 cosh(x), and x -4 tanh(x) in the interval 

[-2, 2]. 

• Several Graphs at Once 

Now draw the above graphs in one figure. 

Distinguish between the three curves using various dashed lines and/or colors. 

• Variations 

Draw a frame with a grid around the above graphic. 

Label the x axis and add a title. 

Use the Times font. 

• The Arc Sine 

Plot the graph of the function x -4 arcsin(x). (What is the appropriate domain of definition?) 

Label both axes. 

Use Tradi tionalForm for labeling the ordinate. 

• Efficiency 

The function Timing displays the time used to evaluate an expression. Compare the timings of 

plots of the following two functions: 

timingTest1 [x_l = Expand [ (1 + Sin [xl ) A 501 ; 

timingTest2[x_l := Expand[ (1 + Sin[xl) A50l; 

Interpret the results . 

• 2.2 Graphs of Functions of Two Variables 

In this chapter we look at graphs of functions 1R2 --) IR. We can visualize them as surfaces, 

contour lines, or density plots. 

The corresponding Mathematica functions are listed in the BasicCalculations > Graphics 

palette or in the Help Browser. 
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• 2.2.1 Surfaces 

In a surface display the rectangular domain appears as the base of a cuboid and the func­

tion values are drawn vertically. The graph then is a surface over the base of the cuboid. 

In[34]:= saddle = Plot3D[x2 -y'-, {x, -1, 1}, {y, -1, 1}]; 

1-1 

Several of the various options (see the documentation on Plot3D and Graphics3D) 

have the same name and work the same way as in two dimensions. 

In[35]:= Show [saddle, PlotLabel ... x 2 - y2] ; 

Here and in the in-depth section we will deal only with the most important additional 

options for three-dimensional objects using examples. 
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With ViewPoint we can change the perspective. A nice tool for this is available from 

the menu Input> 3D ViewPoint Selector. A cube will appear that can be turned with the 

mouse or by entering the coordinates of the point of view. We move the front edge 

upwards. After pressing the Paste button, the following cell is created: 

ViewPoint -> {1.306, -3.120, 0.109} 

This rule can be copied and pasted into the Show function. Alternatively we can prepare 

a cell with the Show command, move the insertion mark to the appropriate position, and 

then use the 3D ViewPoint Selector to paste directly into Show. 

In[36]:= Show[saddle, ViewPoint -> {1.306, -3.120, 0.109}]; 

• In Depth 

• Changing the Box and the Axes 

The Boxed option controls the drawing of the surrounding box. 

In[37]:= Show[saddle, Boxed -> False]; 

1 
O.S 

o 
- O. S 

- 1 
-1 

- O.S 

AxesEdge changes the positioning of the axes. Enter a list of three pairs which determine for the x, 
y, and z axes whether they are to be drawn at the side of the bounding box with larger (+ 1) or 
smaller (- I) coordinates. 
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In[38]:= Show[saddle, AxesEdge-> {{-I, -I}, {-I, I}, {I, I}}]; 

1 

1 

Axes->False hides the axes. 

In[39]:= Show [%%, Axes -> False] ; 

• Colors 

The option value Lighting->False turns off the lighting. Polygons are then shaded according to 

their height. 
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In[40):= Show[%, Lighting -> False] ; 

For diffuse ambient lighting we set: 

In[41):= Show [saddle, AmbientLight -> Hue [1]]; 

1 
0 . 5 

o 
-0.5 

-1 
-1 

-0 . 5 

The colors of the lines and the font can be changed using Defaul tColor . 

In[42):= Show [saddle, Defaul tColor - > Hue [ . 6]] ; 

Part 2 
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The three LightSources have the following default settings: 

LightSources -> {{ {1, 0, 1}, RGBColor[l, 0, oJ}, 

{{1, 1, 1}, RGBColor[O, 1, O]}, {{a, 1, 1}, RGBColor[O, 0, 1]}} 

RGBColor defines a color in the Red, Green, and Blue color model. The preceding lists determine 

the coordinates of the corresponding light sources. 

In[43]:= Show [saddle, LightSources - > {{ {1, 0, 1}, RGBColor [1, 0, O]}, 

{ { 1, 1, 1}, RGBColor [ 0, 1, O]}, {{ 0, 1, 1}, RGBColor [ 0, 0, 1]}}]; 

1 
0.5 

o 
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-1 
-1 
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We can change the light sources. 

In[44]:= Show[saddle, LightSources-> {{{a, -1, 1}, RGBColor[l, 0, OJ}, 

{{a, 0, -1}, RGBColor[O, 1, OJ}, {{a, 1, 1}, RGBColor[O, 0, 1]}}]; 

• A Sphere, First Attempt 

Let us try to draw a unit sphere. 
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In[45]:= Plot3D[Sqrt[1-x A2 _yA2], {x, -1, 1}, {y, -1, I}]; 

Plot3D: :gval : Function value O. + 1. I 
at grid point xi = 1, yi = 1 is not a real number. 

Plot3D: :gval : Function value O. + 0.857143 I 
at grid point xi = 1, yi = 2 is not a real number. 

Plot3D::gva1: Function value O. +0.714286I 
at grid point xi = 1, yi = 3 is not a real number. 

General: :stop : Further output of 
Plot3D: :gva1 will be suppressed during this calculation. 

1 
0.75 

0.5 
0 . 25 

o 
-1 
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1-1 

Various problems arise: 

Part 2 

• We can only use a rectangle as the domain. Outside the unit circle the root becomes complex. 
Mathematica therefore produces error messages. 
• The rectangular grid causes ugly slices. 

• plot3D can display only one function, we therefore lose the bottom half of the sphere. This 
problem could be solved by plotting the bottom half of the sphere separately and then combining the 

two halves with a Show command. 

We will later produce an acceptable figure by a suitable parametric plot. 

• 2.2.2 Contours 

Often a different visualization of functions 1R2 ~ IR is useful. ContourPlot displays the 

rectangular domain from above and shows the contours of constant values of the function. 
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In[46]:= saddle2 = 

ContourPlot[x2 - y 2, {x, -1, 1}, {y, -1, 1}, lmageSize-> 180]; 

The options belonging to ContourPlot can be looked up in the documentation for 

ContourPlot and ContourGraphics. 

Shading can be drawn in color or left out entirely. 

In[47]:= Show[saddle2, ColorFunction -> Hue, lmageSize -> 180]; 

o. 

- 0 . 
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In[4B]:= Show[saddle2, ContourShading -> False, lmageSize -> 180]; 

The Contours option controls the contours to be drawn. We can enter either their 

number or a list of the desired values. 

In[49]:= Show[%, Contours -> 30, lmageSize -> 180]; 

o. 

-0. 
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In[50]:= Show[%, Contours -> {OJ, lmageSize -> 180]; 

0.5 

o 

-0.5 

o 0.5 1 

These lines are, of course, the roots of Xl -l . 

• 2.2.3 Density Plots 

Densi tyPlot represents the function values on a grey or color scale. 

In[51]:= DensityPlot[x2 _y2, {x, -1, 1}, {y, -1, 1}, lmageSize-> 180]; 

o. 

- 0 . c; ll--H-t-t-

Let us make the grid finer using PlotPoints. 
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In[52]:= saddle3 = Densi tyPlot [x2 - y2, {x, -1, 1}, 

{y, -1, 1}, PlotPoints -> 50, ImageSize -> 180]; 

The colored version gives a clearer picture, especially on-screen. 

In[53]:= Show[%, ColorFunction -> Hue, ImageSize -> 180]; 

This looks similar to the colorized version of ContourPlot . 

• In Depth 

• Converting Graphics 

We can interchange the different three-dimensional graphics formats. 
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In[54]:= Show [ContourGraphics[%] , lmageSize -> 160]; 

In[55]:= Show [SurfaceGraphics [%] , lmageSize -> 160]; 

In[56]:= Show [DensityGraphics[saddle] , lmageSize -> 160]; 

o . "'I r+-t-t-t-' 

- 0 . ",Ir-l-++-i...., 
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• Exercises 

• Plotting Graphs 

Plot the graph of the function (x, y) ~ sin(x y) once as a surface, once with contours, and once as a 
density plot. Use the rectangle [0, 2 7T] x [0, 2 7T] as the domain. 

Change the value of PlotPoints to make the pictures look good. 

• Variations 

Colorize the contour and density plots. 

Turn the surface so that you can see it from below. 

• The Arc Tangent 

Plot the graph of the function (x, y) ~ arctan( ~) as a surface. Choose the rectangle [-1, 1] x [-1, 1] 

as the domain. 

The surface is probably not what you expected. For every point in the plane we should be plotting 
the angle between the x-axis and the line from the origin to the point. Therefore the jump of the 

surface along the y axis looks a little strange. It has to do with the choice of branch cuts in 

Mathematica's ArcTan function. Study its documentation and find a better solution. 

• 2.3 Parametric Plots 

With parametric plots we can visualize mappings IR --7 IR 2 , IR --7 IR 3 , or IR 2 --7 IR 3 by 

drawing the image of the domain of definition under the mapping. Depending on the 

dimension of the domain, we get curves or surfaces. 

• 2.3.1 Two-Dimensional Parametric Plots 

ParametricPlot deals with parametric representations of planar curves, i.e. mappings 

IR --71R2. The x-y coordinates are given as a list. 
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In[57]:= ParametricPlot[{Sin[t], Sin[2t]}, {t, 0, 2Pi}]; 

1 

0.5 

-0.5 

-0.5 

-1 

Plotting several curves at once is also possible. 

In[58]:= ParametricPlot [ 
{{Sin[t], Sin[2t]}, {Sin[t], Sin[4t]}}, {t, 0, 2Pi}]; 

The same options as for Plot (and Graphics) can also be used here . 

• 2.3.2 Three-Dimensional Parametric Plots 

We will now look at mappings IR -t IR 3 or IR 2 -t IR 3 . Their images are curves or surfaces 

in 1R3. ParametricPlot3D can be used for both. 

First we plot two space curves given by their parametric representations. 
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In[59]:= ParametricPlot3D[{Sin[t], Sin[2t], Sin[4t] /2}, {t, 0, 2Pi}]; 

1 -1 

In[60]:= ParametricPlot3D[ {Cos [<II], Sin [<II], <II}, {<II, 0, 4 pi}]; 

The second figure becomes clearer if we draw a cuboid with equal edge lengths. 
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In[61]:= Show[%, BoxRatios -> {1, 1, 1}]; 

1 
o. 

o 
-0. 

o 
0.5 

Parametric plots can generate surfaces which do not correspond to graphs of (unique) 

functions 1R2 -7 IR. The surface of the unit sphere is such an example, because both signs 

are possible when the implicit definition r + l + Z2 = 1 is solved for a variable. 

But we can parametrize the surface of the sphere with spherical coordinates. 

In[62]:= x[<9_, I/r_] = Sin[!9] Cos[I/r]; 

In[63]:= y[!9_, I/r_] = Sin[!9] Sin[I/r]; 

In[64]:= z[!9_] =cos[!9]; 

The surface of the sphere is then the image of the rectangle [0, If] x [0, 2 If) under the 

above mapping. 
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In[65]:= ParametricPlot 3D [ 
{x[<9, I/r], y[<9, I/r], z[<9]}, {<9, 0, 7\"}, {I/r, 0, 27\"}]; 

1 

The definitions for x, y, and z are somewhat awkward. These will be used all through the 

current session whenever the patterns x [ ... , ... 1 etc. appear. 

In[66]:= z [1] A 2 

Out[66]= Cos [ 1]2 

It is better to clear the definitions and create the plot directly: 

In[67]:= Clear[x, y, z] 
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In[68]:= ParametricPlot3D[{Sin[<9] Cos[I/r], Sin[<9] Sin[I/r], Cos[<9]}, 
{<9, 0, ".}, {I/r, 0, 2 ".}, lmageSize -> 200]; 

Let us "cut the sphere open" 

In[69]:= ParametricPlot3D [{ Sin [<9] Cos [I/r], Sin [<9] Sin [I/r], Cos [<9]}, 
{<9, "./4, ".}, {I/r, 0, 2".}, lmageSize-> 200]; 

1 

and move closer and upwards to have a better look inside. 

97 
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In[70):= Show[%, ViewPoint -> {0.313, -0.406, 0.SS9}, ImageSize -> 200]; 

-1 
o. 

- 0 . 

1 

. 5 

Small changes produce other lovely surfaces: 

In[71):= ParametricPlot3D[{Sin[t9] Cos[I/!], Sin[t9] Sin[I/!], Cos[3t9]}, 
{t9, 0, 7r}, {I/!, 0, 37r/2}, ImageSize-> 200]; 



Graphics 

In[72]:= ParametricPlot3D[ {Sin [c9] Cos [I/r], Cos [c9] Sin [I/r], Cos [c9] }, 
{c9, 0, IT}, {I/r, 0, 2lT}, ImageSize-> 200]; 

• Exercises 

• A Torus 

A torus can be parametrized by the following x, y, z coordinate functions: 

{Cos[lP] (a+bCos[I/t]), Sin[lP] (a+bCos[I/t]), bSin[l/t]} 

99 

Set a = 2 and b = 1. Then plot the image of the rectangle [0, 2 7f ) x [0, 2 7f) . What is the meaning of 

the parameters a and b? 

Note : if you use transformation rules for inserting values, you may see a message saying that the 

function to be plotted cannot be compiled. In this case it is better to use Evaluate: 

PlotFunction [ 
Evaluate[{Cos[lP] (a+bCos[I/t]), ... } /. {a .... 2, b .... l}], 
{ ... }, { ... }] 

• Cutting Objects Open 

With the selection a = 1 and b = 2 the above torus surface intersects itself. Convince yourself by 

"cutting the object open". 
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• 2.4 Tools from Standard Packages 

Many additional tools are defined in the standard packages which come with Mathematica 

(see Help Browser> Add-ons> Standard Packages> Graphics). They can be loaded on 
demand. A few of them shall be discussed here. (In Version 3.0.x the hyperlinks to 

functions from the standard packages do not work yet. This will be added in future ver­

sions.) 

The command 

In[73]:= < < Graphics' 

makes all definitions in the directory Graphics' available. It must be evaluated before 

any of the examples below . 

• 2.4.1 Three-Dimensional Contour Plots 

The Graphics' ContourPlot3D' package contains the function ContourPlot3D, 

which is similar to ContourPlot. It plots the surfaces on which a mapping 1R3 ~ IR 

takes on constant values. 

Without explicit settings for the Contours option only the roots will be drawn. 

In[74]:= ContourPlot3D [x A 2 - Y A 2 + Z A 2, {x, - 2, 2}, 
{y, -2, 2}, {z, -2, 2}, ImageSize-> 200]; 
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This plots the surfaces corresponding to the function values -1, 0, and 1: 

In[7S]:= ContourPlot3D[x A2 _yA2 + z A2, {x, -2, 2}, {y, -2, 2}, 
{z, -2, 2}, Contours -> {-1., 0., 1.}, ImageSize -> 200]; 

• 2.4.2 Tools for Two-Dimensional Graphics 

The Graphics' Graphics' package contains various tools for logarithmic plots, bar 

and pie charts, data plots with error bars, etc. The documentation is worth a look. We will 

restrict ourselves to two examples. 

In[76]:= LogPlot[Cosh[x], {x, 0, lOll; 
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In[77]:= BarChart [ { 1 , 3,5,3,1}]; 
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1 
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• 2.4.3 Tools for Three-Dimensional Graphics 

The Graphics' Graphics3D' package is also worth a look. 

Let us use ShadowPlot3D and Shadow to project surfaces onto the bounding box. This 

can be very instructive. 

In[78]:= ShadowPlot3D [Sin [x - y] , 
{x, 0, Pi}, {y, 0, Pi}, lmageSize -> 200]; 
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In[79]:= ParametricPlot3D [ 
{Sin[~] Cos[I/I], Cos[~] Sin[I/I], Cos[~]}, {~, 0, 7r}, 

{I/I, 0, 2 7r}, PlotPoints -> {25, 25}, lmageSize -> 200]; 

In[80]:= Shadow [%, lmageSize -> 200] ; 

• 2.4.4 Legends 

The legends defined in Graphics' Legend' can be changed by many options (see 

documentation). 
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In[81]:= Plot[{Sin[x], Cos[x]}, {x, -271", 271"}, 

Plot Style -+ {GrayLevel [0], Dashing [ { .03} ] } , 

PlotLegend -+ {"Sine", "Cosine"}]; 

In[82]:= DensityPlot [Sin[x2 + y2], {x, -3, 3}, {y, -3, 3}, 

PlotPoints -> 50, ColorFunction -> Hue, lmageSize -> 180]; 

Part 2 

The range is the interval [-1, 1]. This is mapped onto [0, 1] by ColorFunction. We 

must therefore label the legend with values between -1 and 1. 
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In[83J:= ShowLegend[%, {Hue, 10, "-1", "1"}]; 

• 2.4.5 Vector Fields 

A useful visualization of mappings IR 2 ~ IR 2 or IR 3 ~ IR 3 can be obtained by drawing the 

image vector as an arrow in each grid point of the domain. The corresponding documenta­

tion can be found in the Graphics ' PlotField' and Graphics' PlotField3D' 

packages. 

The following vector field belongs to a mathematical pendulum: 

In[84J:= PlotVectorField [ {y, - Sin [x] } , 
{x, -Pi, 2 pi}, {y, -pi, Pi}, Axes -> True]; 

... .. ... ",. - ~ .. .. .. .. " ... .... 
~ .. .. .. ~ 

~ .. ., .. ~ 
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With the three-dimensional function PlotVectorField3D the velocity field of a 

rotation around the z axis can be viewed. The VectorHeads->True option setting 

makes sure that the arrow heads are drawn. 

In[85]:= PlotVectorField3D[{-y, x, O}, {x, -1, 1}, 
{y, -1, 1}, {z, -1, 1}, VectorHeads -t True]; 

• In Depth 

• Collisions of Names 

This paragraph deals with a problem which arises when function names are used from packages 

which have not yet been loaded (see Help Browser> Add-ons> Working with Add-ons> Loading 
Packages). 

To get a clear starting point we first end the active kernel session with Kernel> Quit Kernel. 

Now we attempt to create a logarithmic plot using the following command: 

In[1]:= LogPlot [Exp [3 xl, {x, 0, 2} 1 

Out[1]= LogPlot [E3 x, {x, 0, 2) 1 

Because the definition of LogPlot has not yet been loaded with «Graphics' or 

«Graphics' Graphics' , nothing happens. Therefore we try: 

In[2]:= «Graphics' 

But it still does not work: 
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In[3]:= LogPlot [Exp [3 xl I {XI 0 I 2} 1 

Out[3]= LogPlot[E3X , {x, 0, 2}] 

The following command shows that LogPlot is now defined in the global context, but the name 

should be in the context of the package. (Further information to contexts can be found in Section 

4.4.5.) 

In[4]:= ? LogPlot 

Global'LogPlot 

We can solve the problem using Remove. 

In[5]:= Remove [LogPlotl 

Now the context is correct and the command works. 

In[6]:= ? LogPlot 

Graphics'Graphics'LogPlot 

Attributes [LogPlot] = {Stub} 

LogPlot = "Graphics.m" 

In[7]:= LogPlot [Exp [3 xl I {x, 0 I 2} 1 ; 

100 
50 

10 
5 

• Further Parametric Plots 

The Graphics' ParametricPlot3D' package contains, for historical reasons, the Paramet­

ricPlot3D function, which we have already seen. Additional useful tools are Spherical­

Plot3D and CylindricalPlot3D. 

With SphericalPlot3D we need to indicate the radius as function of the spherical coordinate 

angles () and I/t. 
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In[8]:= SphericalPlot3D[l, {t9, 0, 7r}, {I/t, 0, 2 7r}]; 

CylindricalPlot3D draws the z coordinate in function of p and ip (cylindrical coordinates). 

In[9]:= CylindricalPlot3D[p"2, {p, 0, 1}, {cp, 0, 2 7r}]; 

• An Undocumented Tool 

The following option value for automated tick marks at multiples of 7f is unfortunately undocu­

mented. pi Scale can be found in the Graphics' Graphics' package. 
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In[10]:= Plot [Sin[x], {x, 0, 2 Pi}, Ticks -> {PiScale, Automatic}]; 

1 

-0.5 

-1 

• Exercises 

• A Sphere 

rr 
2 

3rr 
-2-

rr 

Plot the surface of a unit sphere using ContourP1ot3D. 

• Logarithmic Plots 

Draw and interpret a logarithmic and a double logarithmic plot of x ---> x3 • 

• Pie Charts 

Draw a pie with piece sizes of 112, 114, 116, 1112. 

• Projections of Surfaces 

109 

Draw a parametric plot of {Sin[G]Cos[I/r/2] ,Sin[G]Sin[l/r] ,Cos[G]} for the parameter 

domain {G, 0 , rr}, {I/r, 0 , 4rr} . 

Study the surface by projecting it onto three planes of the bounding box. 

• Legends 

Go back to the above example for legends and move the legend to the right -hand side of the plot. 

• Cones 

Use Cy1indrica1Plot3D to draw a cone. 

Deform it into a corrugated surface by adding a small rp-dependent sine modulation. 

• Vector Fields 

Draw a vector field of the mapping IR 2 ---> IR 2 , given by (x, y) ---> (x - y, x + y). 
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.2.5 Animations 

Sometimes an additional dimension of a problem can be visualized by mapping a parame­

ter (or a variable) on the time. The Cell> Animate Selected Graphics command animates 
a selected group with graphics cells. The cell group can either be created using the func­

tions in the Graphics' Animation' standard package, or "by hand". We will study 

the second option in the third part, two examples of the first one are shown here. Naturally 

the animation works only on-screen. The book shows the first figure of the sequence. 

If the group of Graphics' packages has not yet been loaded you must at least load the 

animation package at this point. 

In[11]:= «Graphics'Animation' 

We create the graphics by varying a parameter with the help of Animate. The list {n,­

. 4 , 1, . 2} contains the variable, the initial value, the end value, and finally the step size. 

In[12]:= Animate [Plot [x' - n X2, {x, -I, I}, 
PlotRange-+{All, {-.25, I}}], {n, -.4, I, .2}] 

1 

0.8 

0.6 

0.4 

0.2 

-1 -0.5 0.5 1 

-0.2 

The above cell group can be animated on-screen using the Cell > Animate Selected 

Graphics command or by double-clicking on the graphic. In the bottom left-hand comer 

of the notebook window a "control board" appears which you can use to change, among 

other things, the direction and the speed of the animation. 

To make the animation run smoothly the axes ranges must be identical for all figures. This 

is achieved by an explicit setting for PlotRange. 

In this example a three-dimensional view would of course also be possible. 
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In[13]:= Plot3D[x4 - nx2 , {x, -1, 1}, {n, - .4, 1}]; 

1 

With three-dimensional graphics this IS not so easy. You will find an example in the 

exercises. 

Let us draw the "pillow" from above again, this time without box or axes. 

In[14]:= spinDemo = ParametricPlot3D [ 
{Sin[t9] Cos[I/!], Cos[t9] Sin[I/!], Cos [t9]}, {t9, 0, ]f}, 

{I/!, 0, 2 ]f}, Axes -> False, Boxed -> False, ImageSize -> 180]; 

SpinShow rotates the object. Because of the symmetry a half tum is enough. 
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In[15]:= SpinShow[spinDemo, Frames -> 10, SpinRange -> {O, pi} ] 

(Close the cell group in the notebook, select it, then choose Cell > Animate Selected 

Graphics.) 

Further functions and options can be found in the documentation of Graphics' Anima­

tion' . 

• Exercises 

• Parameters in a Function of One Variable 

Create an animation where the sine function over a period is moved to the right in ten steps. A 
possible solution can be animated in the notebook: 

1 

2 5 6 

-0.5 

-1 

Try out the different buttons on the "control board" in the bottom left corner of the window. 

• Parameters in a Function of Two Variables 

Look at the function (x, y) -7 n2 (sin x + sin y)2 + cos X + cos y with the parameter n. 

First plot the graph in the domain [-If, lfJ x [-If, lfJ and for n = o. 
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Visualize the changes in the surface as the parameter n varies in the interval from 0 to 1 (increment 

length 1/10). Make sure that the "movie" does not show any tears due to incompatible axis scales. 

• Your Own Example 

Construct your own example for a MovieParametricPlot. 

• 2.6 Exporting to Other Programs 

Not all readers do all their work in Mathematica-even though the text system is adequate 

for many applications, e.g., for writing this book. There might still be some need to export 

graphics and formulas to other programs. 

Exporting formulas is somewhat unsatisfactory, since they lose their mathematical content 

during export and exist only as graphics. But the technology is exactly the same as for 

graphics. 

The most versatile technique is saving the graphic (or formula) in a file and then importing 

this file into a word processing or graphic program. The EPS format gives the best results, 

because it prints perfectly and because the format is available on all platforms. The 

following steps do the job: 

1. Select the graphic. 

2. Menu Edit> Save Selection As ... > EPS. 

3. Name the file. 

4. Save the file. 

The Adobe Illustrator format can be very useful for owners of the program. It allows the 

manipulation of the figures in all ways possible in Illustrator. 

Depending on the computer platform, the menu Edit> Save Selection As •.. may contain 

other formats. They sometimes give less perfect results after export to files or via the 

clipboard (Edit> Copy As). 

• Exercise 

• Saving a Graphic in a File 

Plot the function x ~ 2x in the interval [-2, 2]. 

Export the graphic in EPS format and import it into your word processing program. 



Part 3: Lists and Graphics 
Programming 

Lists are the most important objects in Mathematica. They appear everywhere, visibly or 

hidden. Once you learn to use them properly, it will make working with the program that 
much simpler. 

In this part we will increase our knowledge of lists in-depth, then apply them to solve 

simple linear algebra problems and to create our own graphics. 

S. Kaufmann, A Crash Course in  Mathematica
© Birkhäuser Verlag 1999
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• 3.1 Lists 

• 3.1.1 Creating One-Dimensional Lists 

We already know that lists are objects whose elements are placed into curly braces. 

In[1]:= {1, 4, 9} 

Out[1]= {I, 4, 9} 

The Mathematica function Table is useful for creating lists. It evaluates an expression 

for different values of an iterator. 

In[2]:= Table [i 2 , {i, 10}] 

Out[2]= {I, 4, 9, 16, 25, 36, 49,64,81, 100} 

The list in the second argument of Table contains the name of the iterator and further 

information. The following forms are possible (i is the iterator): 

• {n} creates n identical entries (with no iterator present) 

• {i, n} varies i over 1, 2, ... , n 

• {i, a, n} varies i over a, a + 1, ... , n 

• {i, a, n, s} varies i over a, a+s, a+2s, ...• n*. where n*",n 

In[3]:= Table [a, {10} 1 

Out[3]= {a, a, a, a, a, a, a, a, a, a} 

In[4]:= Table[i2, {i, 0, 10}l 

Out[4]= {O, 1, 4, 9, 16, 25, 36, 49, 64, 81, 100} 

In[5]:= Table [i 2 , {i, 0, 1, • 3 } 1 

Out[5]= { 0, O. 09, O. 3 6, O. 81 } 

Arithmetic sequences can be created more easily using Range. No name is needed for the 

iterator in this case. 

In[6]:= Range [10l 

Out[6]= { 1, 2, 3, 4, 5, 6, 7, 8, 9, 10} 
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In[?]:= Range [0, 10] 

Out[?]= {a, 1, 2, 3, 4, 5, 6, 7, 8, 9, 10} 

In[8]:= Range [ 0, 1, . 3 ] 

Out[8]= {a, 0.3, 0.6, 0.9} 

• 3.1.2 Manipulating Lists 

Many functions are available for the manipulation of lists (see Section 1.8 of the Mathemat­

ica Book). A few useful examples follow. 

Our exercise object is: 

In[9]:= list1 = {a, b, c, d, e} 

Out[9]= {a, b, c, d, e} 

The function Length determines its length (what a surprise!). 

In[10]:= Length [list1] 

Out[10]= 5 

We already know how to extract elements. 

In[11]:= list1 [[2]] 

Out[11]= b 

Or in StandardForrn: 

In[12]:= listl[2] 

Out[12]= b 

Take can extract entire sublists. A positive number as second argument results in the 

same number of elements from the left. Negative numbers count the elements from the 

right. If we pass a list with a start and end number in the second argument, Take returns 

the corresponding sublist. 

In[13]:= Take[list1, 3] 

Out[13]= {a, b, c} 
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In[14]:= Take[listl, -3] 

Out[14]= {c, d, e} 

In[15]:= Take[listl, {2, 4}] 

Out[15]= { b, c, d} 

Drop functions analogously and throws the corresponding elements away. 

In[16]:= Drop [listl, 3] 

Out[16]= {d, e} 

In[17]:= Drop[listl, -3 ] 

Out[17]= {a, b} 

In[1B]:= Drop[listl, {2, 4}] 

Out[1B]= {a, e} 

Rota teRight permutes the elements of a list cyclically to the right. 

In[19]:= RotateRight [listl] 

Out[19]= fe, a, b, c, d} 

In[20]:= RotateRight [listl, 2] 

Out[20]= {d, e, a, b, c} 

Sort rearranges the elements according to a sort order. 

In[21]:= Sort [%] 

Out[21]= {a, b, c, d, e} 

Lists can be joined using Join. 

In[22]:= Join[listl, {f, g}] 

Out[22]= {a, b, c, d, e, f, g} 

Or we can use the function Flatten, which "flattens out" a nested list into a one­
dimensional one. 
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In[23]:= Flatten[{list1, {f, g}}] 

Out[23]= { a, b, c, d, e, f, g} 

Or we can use Append twice, to add an element to the end each time. 

In[24]:= Append[Append[list1, f], g] 

Out[24]= {a, b, c, d, e, f, g} 

Pos i tion gives the position(s) of a pattern; the corresponding elements can be extracted 

with Extract. 

In[25]:= list2 = {a"2, b, b, c, d"2, b, e} 

Out[25]= {a2 , b, b, c, d 2 , b, e} 

In[26]:= position[list2, b] 

Out[26]= {{2}, {3}, {6}} 

In[27]:= Extract [list2, %] 

Out[27]= { b, b, b} 

In[2B]:= Position[list2, _ "2] 

Out[2B]= {{1}, {5}} 

In[29]:= Extract [list2, %] 

Out[29]= {a2 , d 2 } 

Select tests the elements of a list for properties. The list must be given together with a 

function, which returns True for the desired elements. 

In[30]:= myTest [x_] = (x> 10) && (x < 50) 

Out[30]= x> 10 && x < 50 

In[31]:= Select [Table [i" 2, {i, 10}], myTest] 

Out[31]= {16, 25, 36, 49} 

One of the exercises shows that lists can also be used for set calculations. 
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• 3.1.3 Multidimensional Lists 

Table can also create multidimensional lists: 

In[32]:= Table [a A i + b A j, {i, 3}, {j, 3}] 

Out[32]= {{ a + b, a + b 2 , a + b 3 } , 

{a2 +b, a 2 +b2 , a 2 +b3 }, {a 3 +b, a 3 +b2 , a 3 +b3 }} 

The function MatrixForrn displays the list as a matrix. 

In[33]:= MatrixForm [%] 

Out[33]IIMatrixForm= 

I a + b a + b 2 

a 2 + b a 2 + b 2 

a 3 + b a 3 + b 2 

• Exercises 

• Prime Numbers 

Create a list of all odd numbers between 106 and 106 + 103 • 

Part 3 

The function PrimeQ tests whether a number is prime. Use it and Select to determine the prime 
numbers in the above list. 

• Sets 

Use the functions Union and Intersection to fonn the union and the intersection of the sets 
{a, a, b, C, d, e, f} and {a, f, g, g, j}. Note that Union can also be used to get rid of duplicated 

elements in a list . 

• 3.2 Calculating with Lists 

• 3.2.1 Automatic Operations 

Many functions of one argument are automatically mapped onto the elements of lists. 

In[34]:= Sin[{l, 2, 3}] 

Out[34]= {Sin[l], Sin[2], Sin[3]} 
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This multiplies each element of the list by 3: 

In[35]:= 3 {a, b, c} 

Out[35]= {3 a, 3 b, 3 c} 

The (normal) product is calculated element-wise. 

In[36]:= {a, b, c} {l, 2, 3} 

OUI[36]= { a, 2 b, 3 c} 

For more involved problems there are also the functions Inner and Outer, which 

calculate generalized inner and outer products. 

Scalar and cross products are predefined in the functions Dot and Cross, even though 

you could also easily do this yourself (there is an exercise for it). 

In[3?]:= Dot[{x, y, z}, {u, v, w}] 

OUI[3?]= u x + v y + w z 

In[38]:= Cross [{x, y, z}, {u, v, w}] 

Out[38]= { w Y - v z, - w x + U z, v x - u y} 

We can even write these in the following notation: 

In[39]:= {x, y, z}. {u, v, w} 

Out[39]= U x + v y + w z 

In[40]:= {x, y, z} x {u, v, w} 

Oul[40]= {w y - v z, - w x + U z, v x - U y} 

• 3.2.2 Mapping Functions on Lists 

The automatic mapping of functions on lists will not solve all our problems. For example, 

let us look at Variables which delivers the variables in a polynomial. 

In[41]:= variables [x + y] 

Oul[41]= {x, y} 

If we apply this function to a list, we get a flat list of all variables in the original list. 
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In[42]:= variables [{x + y, x + z, y}] 

Out[42]= {x, y, z} 

But what are the variables of the single elements of the list? An iteration over the elements 

is somewhat awkward: 

In[43]:= Table [Variables [{x + y, x + z, y} [iD], {i, 3}] 

Out[43]= {{x, y}, {x, z}, {y}} 

As part of a complicated program, this would have the disadvantage that we first have to 
determine the length (possible with Length) and that the construction is hard to read. 

Therefore Mathematica offers the possibility of mapping functions of one argument onto 

lists using Map. 

In[44}:= Map[variables, {x+y, x+ z, y}] 

Out[44]= {{ x, y}, {x, z}, {y}} 

Because Map appears often in programs, there is also a short notation: 

In[45]:= Variables /@ {x + y, x + z, y} 

Out[45]= {{x, y}, {x, z}, {y}} 

• 3.2.3 Pure Functions 

In the example for Select we defined an auxiliary function 

In[46]:= myTest [x_] = (x> 10) && (x < 50); 

to recognize the desired list elements. Often we need this kind of tool only once, so there 

is no point in giving it a name. This can be avoided with the help of pure functions. The 

pure function for this problem can be written with Function and looks like this: 

In[47]:= Function [x, (x> 10) && (x < 50)] 

Out[47]= Function [x, x> 10 && x < 50 1 

The first argument of Function contains the name of the auxiliary (local) variable x, the 

second argument is the expression in x to be evaluated. Such objects are applied in the 

usual way. In the following example the argument 9 is substituted for x and the function 

body evaluated. 
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In[48]:= Function[x, (x> 10) &:&: (x < 50)] [9] 

Out[48]= False 

Pure functions can easily be mapped on lists 

In[49]:= Function[x, (x> 10) &:&: (x < 50)] /@ {l, 20, 100, 30} 

Out[49]= {False, True, False, True} 

or used in functions like Select. 

In[50]:= Select [Table [i" 2, {i, 10}], Function[x, (x> 10) &:&: (x < 50)]] 

Out[50]= {16, 25, 36, 49} 

Now we do not need the name x in the pure function either. We can replace it with # and 

write only the function definition. 

In[51]:= Select[Table[i"2, {i, 10}], Function[(#> 10) &:&: (#<50)]] 

Out[51]= {16, 25, 36, 49} 

Because this also appears often, there is an even shorter way to write it: leave out the 

Function and delimitate the pure function with a &. 

In[52]:= Select[Table[i"2, {i, 10}], (# > 10) &:&: (# < 50) &:] 

Out[52]= {16, 25, 36, 49} 

In this way we can easily calculate the partial derivatives of the expression 

x-y 

with respect to x, y, z, i.e. the gradient. 

x-y 
In[53]:= D[ , #] &: /@ {x, y, z} 

.yx2 + y2 + Z2 

{- x (x-y) 1 
Out[53]= 

(x2 + y2 + Z2 ) 3/2 
+ 

yx2 +y2 +Z2 

(x-y) y 1 (x-y) Z 

(X2 + y2 + Z2 ) 3/2 yx2 + y2 + Z2 
, 

(X2 + y2 + Z2 ) 3/2 
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In a pure function with several arguments, these are either combined into a list (when 

Function is used with two arguments) or indicated with #1, #2, ... (in the short nota­

tion). 

In[54]:= Function[{x, y, z}, Sqrt[xA2+yA2+zA2]] 

Out[54]= Function[{x, y, z}, -YX2 +y2 +Z2] 

In[55]:= %[a, b, c] 

Out[55]= -y a 2 + b 2 + c 2 

In[56]:= Function [Sqrt [#1 A 2 + #2 A 2 + #3 A 2] ] [a, b, c] 

Out[56]= -ya2 + b 2 + c 2 

Of course we can also write definitions with pure functions. 

In[57]:= geometricMean = (#1 #2 #3) A (1/3) &:; 

In[58]:= geometricMean [a, b, c] 

Out[58]= (a be) 1/3 

The alternative definition of the form 

In[59]:= geometricMean1 [x_, y _, z_] : = (x y z) A (1 / 3) 

In[60]:= geometricMean1 [a, b, c] 

Out[60]= (a be) 1/3 

is a definition for the pattern geometricMeanl [x_, y_, z_l. In contrast, the pure 
function 

In[61]:= geometricMean = (#1 #2 #3) A (1/3) &:; 

can be interpreted as a definition for the head geometricMean (see Section 4.1) . 

• 3.2.4 Using List Elements as Arguments 

To conclude this first look at some exotic constructions, let us discuss Apply. It is used to 
apply the elements of a list as arguments of a function. 
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In[62]:= Apply[f, {a, b, e}] 

Out[62]= f [a, b, c 1 

This is, of course, different from: 

In[63]:= f[{a, b, e}] 

Out[63]= f [ {a, b, c} 1 

We now consider the addition function Plus which we normally write using the operator 

+ (see Section 4.1). If we apply it to a list using Apply, we get the sum of the elements 

In[64]:= Apply[Plus, {a, b, e}] 

Out[64]= a + b + C 

or, analogously, the product using Times: 

In[65]:= Apply[Times, {a, b, e}] 

Out[65]= abc 

There is also an infix notation: 

In[66]:= Plus @@ {a, b, e} 

Out[66]= a + b + C 

In[67]:= Times @@ {a, b, e} 

Out[67]= abc 

The above function for the geometric mean has the disadvantage that the number of 

arguments is set at three. We can now define a variation which handles a list of indetermi­

nate length. 

In[68]:= geometrieMean2 = (Times @@ #) 1\ (1 / Length [#]) &:; 

In[69]:= geometrieMean2 [{a, b, e, d, e}] 

Out[69]= (a bed e) 1/5 

Of course, we also have built-in functions for indexed sums and products: Sum and 

Product. They work like Table. 
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In[70]:= Sum [ a " i, { i, 5}] 

• 3.2.5 Plotting Lists 

There are variations to almost all graphic functions to plot lists of values. Their names 

always begin with List (ListPlot, ListPlot3D, ListContourPlot, etc.). The 

data can be taken from Mathematica itself or can be imported from other programs using 
ReadList (see the in-depth section). 

We create a list with a couple of numerical values of the cosine function. 

In[71]:= cosList = Table [N [Cos [x] ], {x, 0, 2 Pi, 2 pi / 50}] ; 

ListPlot plots these points. 

In[72]:= ListPlot [cosList] ; 

1 .... . .. 

0.5 

10 20 30 ·40 50 

-0.5 

-1 .... 

They are joined with the option PlotJoined->True. 

In[73]:= ListPlot [cosList, PlotJoined -> True] ; 

1 

0.5 

50 

-0.5 

-1 
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The abscissa is labeled with the entry numbers in the list (1, ... , 51) in this case. But we 

can also plot a list of point pairs, which gives us useful scales on both axes. 

In[741:= Short [xCosxList = Table [N[ {x, Cos [xl}], {x, 0, 2 Pi, 2 pi /50}] ] 

Out[741I1Short= 

{{O, 1.}, «49», {6.28319, 1.}} 

In[751:= ListPlot [xCosxListj ; 

1 '. ." 

0.5 

1 2 3 4 5 6 

-0.5 

-1 .... 

• In Depth 

• Solutions of Differential Equations as Pure Functions 

We have seen in the in-depth to Section 1.4.6 how the solution of a differential equation can be 
requested as a pure function. This form is useful if the derivative of the solution must be calculated 

(we will look at the detailed reason for it in the in-depth to Section 4.2). It allows us, for instance, to 
draw a parametric plot in the phase space {x(t), x' (t)J. 

As an example, let us look at the numerical solution of the nonlinear oscillation equation 

x" (t) + sin(x(t)) = 0 with {x(O) = 1, x' (0) = OJ. 

In[76]:= NDSolve[{x" [t] +Sin[x[t]] == 0, x[O] == 1, x' [0] == OJ, x, {t, 0, 5}]; 

In[771:= parametricPlot[Evaluate[{x[t], x' [t]} /. %[[1]]], {t, 0, 5}]; 

0.5 

-0.5 0.5 

-0.5 
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(Evaluate makes sure that the transformation rule is applied before the curve is plotted.) 

• The Efficiency of Numerical Sums 

You will calculate many numerical sums in the exercises. To increase the numerical efficiency, the 
following consideration is useful. 

We first look at the sum: 

In[7S]:= Sum[l/ iA 3, {i, 10}] 

Oul[7S]= 
19164113947 

16003008000 

Mathematica calculates a priori with exact rational numbers. Of course this becomes very compli­

cated for larger sums, therefore it is essential to change to approximate numbers as quickly as 
possible. 

In[79]:= Sum[l/N[i] A3, {i, 10}] 

Oul[79]= 1.19753 

After increasing the number of terms, we can look at the difference in CPU times using the function 

Timing. In addition to the result, it also shows the processing time. The result of the first calcula­

tion produces a large fraction, which we will suppress. 

In[80]:= Timing [Sum [1/ iA 3, {i, 1000}];] 

Oul[SO]= {1.68333 Second, Null} 

In[81]:= Timing [Sum [1 / N[i] A 3, {i, 1000} 1; 1 

Oul[81]= {0.0666667Second, Null} 

• Saving and Reading Lists 

We will end this in-depth section with an example for reading external data. First we create a list to 

work on, one which is comprised of values of the sine function with a superimposed "noise" (created 
with Random ). 

In[82]:= data = Table [Sin [x] + Random [Real, {-.03, .03}], {x, 0, 2Pi, 2Pi/200}]; 
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In[83]:= ListPlot [data] ; 

1 

0.5 

50 10'-Q 150 4: 0 

"' 
~ 

-0.5 \. " .; 
/ 

"'"11. ... 

-1 ....... Nf'.-

We save the list in a file with the Save command. 

In[84]:= Save ["data .m", data] 

Now we clear the definition. 

In[85]:= Clear [data] 

In[86]:= data 

Out[86]= da ta 

The following command reads it again: 

In[87]:= «data.m; 

In[88]:= ListPlot[data]; 

", ....... 
/' '-'\ 

.1 \. 

1 

0.5 

,1 ' .. 
50 10'-Q 150 4: 0 

\. ~ 

-0.5 \.\ " .; 
/ T..... .. ... 

-1 '''''',Nf\ .. '" 

But a look at the file da ta . m shows that the data was saved in the usual Mathematica format. It 

cannot therefore be used as an example for data which was created in another program. Without 

further explanation, we will accept that the following command writes the data unformatted into 

single lines: 

In[89]:= PutAppend[#, "pure-data"] &: /@ data; 

A look at the file pure-da ta proves it. For this we use either the Mathematica command: 

! ! pure-data 
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which prints the file on screen (we will not show this uninteresting printout here), or we could as well 

open the file using the command File> Open in the front end, 

Now we can use the function ReadList to read the data from this file again, 

In[90j:= external Data = ReadList ["pure-data" j ; 

In[91j:= ListPlot[externalDataj; 

1 

0,5 

-0,5 

-1 

When reading structured data, for example Excel sheets which have been saved as text, the sequence 

of data types can be entered as second argument in ReadList, 

• Exercises 

• A Logarithm Table 

Create in at least two different ways a table of natural logarithms of the numbers between 1 and 10, 

Now create a list which contains the pairs In, log(n)}, (TableForm displays it as a table,) 

How can the above be solved with a pure function which is mapped onto Range [ 1 , 10 I ? 

• The Gradient 

Define a function named gradient, which calculates the gradient of an expression in the simplest 

way, The first argument should be the expression, the second a list of the variables, 

• Pure Functions 

Create with 

aList=Table[i+j, {i, lO}, {j, Random[J:nteger, {1, 10}]}] 

a nested list with sublists of different lengths, Now use pure functions to 

• calculate the lengths of the sub lists, 

• throw out the first element of each sublist, 

• rotate all sublists to the left by two elements, 

• determine the sum of the elements in each sublist. 
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• Dot and Cross Products 

Define your own functions to calculate the scalar and the cross product of two vectors. 

• A Riddle 

What does the following function do when it is applied to two lists of length 3: 

riddle [u_1 v _] : = RotateLeft [u RotateLeft [v] - RotateLeft [u] v] 

• Sums 

What does the Mathematica function Sum give for Li:' i2~i and L:, i3~i2'? 

• Variations Using Apply 

Find at least three different ways of calculating the sum of the squares of all integers between 1 and 

10000. Use the function Timing, to compare processing times. 

• Plots of Lists; Sums and Series 

Before calculating sums, look at the observations on efficiency in the in-depth section. 

Plot the list of points l..., i = 1, ... , 500. 
I 

Visualize the behavior of the sums L:=, +, for n = 1, ... , 500, graphically. 

The (infinite) harmonic series seems to diverge. What is Mathematica's comment to this? 

Compare with the behavior of Li:, t. 
~= , 

Calculate the exact result for the series L.J i=, 12' 

• 3.3 Linear Algebra 

Mathematica can also be used for linear algebra. 

Several useful matrices are already pre-defined. Identi tyMa trix gives us the identity 

matrix of the selected dimension. 

In[92]:= Identi tyMatrix [3] 

Out[92]= {{1, 0, O}, {O, 1, O}, {O, 0, 1}} 

DiagonalMatrix simplifies the definitions of diagonal matrices. 

In[93]:= diag = DiagonalMatrix[{a, b, c}] 

Out[93]= {{ a, 0, O}, {O, b, O}, {O, 0, c}} 



132 Part 3 

As we have already seen, Ma trixForm produces a pretty print of matrices. 

In[94]:= MatrixForm[diag] 

Out[94]IIMatrixForm= 

[
a 0 0) 
o b 0 
o 0 c 

The inverse is calculated using Inverse. 

In[95]:= MatrixForm [Inverse [diag] ] 

Out[95V/MatrixForm= 
1- 0 0 a 

0 1 0 b 

0 0 1 
c 

The . operator calculates the matrix product. It is a short form of the Dot function. 

In[96]:= MatrixForm[%. diag] 

Out[96V/MatrixForm= 

[ 1 0 0) 
o 1 0 001 

Dot automatically sums over the last index of the first factor and the first index of the 

second factor. Therefore a list as first factor is a line vector and a list as second factor is a 

column vector. 

In[97]:= {a, b}.{{l, 2}, {1, 2}} 

Out[97]= {a + b, 2 a + 2 b} 

In[98]:= {{ 1, 2}, {1, 2}}. {a, b} 

Out[98]= {a + 2 b, a + 2 b} 

The awkward differentiation between 

In[99]:= {{a, b}}.{{l, 2}, {1, 2}} 

Out[99]= {{a+b,2a+2b}} 

In[100]:= {{ 1, 2}, { 1, 2}}. { {a}, {b }} 

Out[100]= {{a+2b}, {a+2b}} 
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is usually unnecessary. 

Now we work with a slightly more complicated 3x3 matrix. 

In[101j:= matl = {{a, c, 1}, {a, b, c}, {1, -b, 1}} 

Out[101j= {{a, c, I}, {a, b, c}, {l, -b, I}} 

In[102j:= MatrixForm[matl] 

Out[102jIIMatrixForm= 

[~ -~~) 
In[103j:= MatrixForm[Inverse [matl]] 

Out[103jIIMatrixForm= 

b+bc -b-c 
-b-a c+a b c+c2 -b-a c+a b c+c2 -b-a c+a b c+c 2 

-l+a 
-b-a c+a b c+c 2 -b-a c+a b c+c2 -b-a c+a b c+c 2 

a b+c ab-a c 
-b-a c+a b c+c2 -b-a c+a b c+c2 -b-a c+a b c+c2 

In[104j:= MatrixForm [SimplifY [% • matl]] 

Out[104jIlMatrixForm= 

[: : :) 
The transposed matrix is calculated using Transpose 

In[105j:= MatrixForm [Transpose [matl]] 

Out[105jIIMatrixForm= 

the determinant using Det. 

In[106j:= Det [matl] 

Out[106j= - b - a c + abc + c 2 
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• In Depth 

• An Application of Transpose 

The function Transpose can be useful for problems which have little to do with linear algebra. 

For example, let us look at a list of data which might come from an experiment and have been read 

with ReadList. 

In[107]:= expData= Table[N[Exp[-t] Cos[t]], {t, 0, 3, .3}] 

Qul[107]= {1., 0.707731,0.452954,0.252728,0.10914,0.0157836, 

-0.0375563, -0.0618217, -0.0668948, -0.0607586, -0.0492888} 

The corresponding values of the variable t are also given as list: 

In[1081:= tValues = Range [0, 3, .3] 

Qul[108]= {O, 0.3, 0.6, 0.9, 1. 2, 1. 5, 1.8, 2.1. 2.4, 2.7, 3.) 

To create a list of matching pairs with Li s tP lot we could of course iterate as follows: 

In[1091:= listPlotdata = 
Table[{tValues[[i]], expData[[i]]}, {i, Length[tValues]}] 

Qul[109]= { { 0, 1.}. {O. 3, O. 70773 1 }. {O. 6, O. 452954 }. 

{0.9, 0.252728}. {1.2, 0.10914}. {1.5, 0.0157836}. 
{1.8, -0.0375563}. {2.1, -0.0618217}. 

{2.4, -0.0668948}. {2.7, -0.0607586}. {3., -0.0492888}} 

In[l10j:= ListPlot[listPlotdata]; 

1 

0.8 

0.6 

0.4 

0.2 

0.5 1 1.5 . 2· 2.5· 3 

However this is much more elegant: 
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In[111]:= ListP1ot[Transpose[ {tVa1ues, expData}]]; 

1 

0.8 

0.6 

0.4 

0.2 

0.5 

• Exercises 

1 1.5 . 2· 2.5· 3 

• A Set of Simultaneous Equations 

135 

Let us look at the set of equations {2 x + 5 y + z = 1, 3 x - y - z = 2, x + 5 y + 3 z = I}. Solve it in 

two ways: 

• with the function Solve, 

• by determining the coefficient matrix and calculating the result using its inverse. 

• Reading Programs 

The steps below automate the above calculation. Try to understand them. 

It is not necessary that the terms with the variables are on the left-hand side of the equations and the 

constant vector on the right. Therefore we first put everything on the left-hand sides and use this as a 

list. 

In[112]:= equations = {2 x + 5 y + Z == 1, 3 x - y - z == 2, x + 5 y + 3 z == 1}; 

In[113]:= 1hs = (#[1] - #[2] &:) I@equations 

Out[113]= { -1 + 2 x + 5 y + z, - 2 + 3 x - y - z, -1 + x + 5 y + 3 z} 

Here we can determine the coefficient matrix, using the Coefficient function, as 

In[114]:= Coefficient[#, {x, y, z}] &: l@lhs 

Out[114]= {{2, 5, 1}. {3, -1, -1}. (1, 5, 3)) 

We obtain the vector by setting the variables to zero. Thread does this the fastest. (What does 

Thread [{x, y, Z }--7{ O,O,O}] do? What does Thread [{x, y, Z }--70] do?) 

In[115]:= 1hs I. Thread [ {x, y, z} -+ 0] 

Out[115]= {-1, -2, -1} 

Only the sign of the vector needs to be changed, because we have written everything on the left-hand 

side of the equation. This allows us to define the following two functions: 
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In[116):= coefficientMatrix[equations_, vars_) : = 
(Coefficient[#, vars) &:) /@ (#[1] - #[2] &:) /@equations 

In[117):= vector [equations_, vars_) : = 

(#[2] - #[1] &:) /@equations /. Thread [vars .... 0) 

In[118):= coefficientMatrix[ {2 x + 5 y + Z == W - 1, 
3x-y-z-w+2==0, 1==x+5y+3z,w+x==2}, {x,y, z,w}) 

Out[118)= { (2, 5, 1, - 1), (3, - 1, - 1, - 1 ), {- 1, - 5, - 3, O}, {1, 0, 0, 1}} 

In[119):= vector [ {2 x + 5 Y + z = = w - 1, 3 x - y - z - w + 2 = = 0, 
1==x+5y+3z,w+x==2}, {x,y, z,w}) 

Out(119)= ( -1, -2, -1, 2) 

• 3.4 Graphics Programming 

• 3.4.1 Graphics Objects 

Mathematica recognizes various two-dimensional graphics pnmmves: Point, Line, 

Rectangle, Polygon, Circle, Disk, Raster, and Text. We can create a list 

containing such graphics primitives, use it in a Graphics object, and draw the illustra­
tion with Show. 

In(120):= Show [Graphics [ 

{Line [ {{ 0, O}, {1, 1}}], 

Circle [{O, O}, Sqrt [2]], 
Text [ n Radi us", {. 8, .4}]}] 1 ; 

Radius 

All Graphics options, which we have already met as additional options of Plot, can be 

used to change the default values. 
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In[121]:= Show[%, Axes -> True, AspectRatio -> 1, lmageSize -> 180]; 

1 

0.5 Radius 

-1 -0.5 0.5 1 

-0.5 

-1 

Graphics directives define properties of graphics pmmtlves using, for instance, color 

(Hue, etc.), different point sizes (PointSize and AbsolutePointSize), thicknesses 

(Thickness and AbsoluteThickness), and dashes (Dashing and Absolute­

Dashing). 

For graphics directives which begin with Absolute, the value is given in pixels, those 

without Absol u te use the percentage of the width of the graphic. 

Graphics directives are valid for the successive elements of the list in which they appear 

and for its sublists. 

Here AbsoluteThickness has an effect on all the rest: 
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In[122]:= Show [Graphics [ 
{AbsoluteThickness[3], 
Line [ { {O, O}, {1, 1}}], 
Circle [{O, O}, Sqrt [2]], 
Text[IRadius", {.8, .4}]}], 

Axes -> True, AspectRatio -> 1, lmageSize -> 180]; 

This way the "radius" is not drawn thickly: 

In[123]:= Show [Graphics [ 
{Line[{{O, O}, {1, 1}}], 
AbsoluteThickness[3], 
Circle[{O, O}, Sqrt[2]], 
Text["Radius", {.8, .4}]}], 

Axes -> True, AspectRatio -> 1, lmageSize -> 180] ; 

Now we enter the radius and the circle in a sublist, use AbsoluteThickness on it, and 

then draw a small thin circle in the middle. 
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In[124]:= Show [Graphics [ 
{{AbsoluteThickness[3], 

Line[{{O, OJ, {1, 1}}], Circle[{O, OJ, Sqrt[2]]}, 
Circle[{O, OJ, .05], Text [RRadius R, {.8, .4}]}], 

Axes -> True, AspectRatio -> 1, lmageSize -> 180] ; 

• 3.4.2 Graphics3D Objects 

139 

Everything works the same way with three-dimensional graphics objects. Cuboid, Line, 

Point, Polygon, and Text are available as graphics primitives. Lists of such primi­

tives, perhaps together with graphics directives, are written into a Graphics3D object 
and drawn using Show. 

As an example, we draw 100 randomly placed cubes. To create the list of corner points, 
we use the (pseudo) random generator Random. In its simplest call version, without an 

argument, the results lie in the interval [0,1]. Therefore 

In[125]:= Table [ {Random [ ], Random [ ], Random [] }, {1 0 0 } ] ; 

returns a list of 100 "random" number triples. The Cuboid primitives are unit cubes with 

given corner points (as long as only one argument is given). We scale the coordinates by 

factor 20 so that the cubes will not all overlap. We can map Cuboid onto the list of 

coordinates using Map or /@ and put the results into a Graphics3D object. 
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In[126]:= Show [Graphics3D [Cuboid /@ 
(20 Table [{Random[], Random [], Random [] }, {lOa}])], 

lmageSize -> 180]; 

Part 3 

For a random colorization of the cubes (with SurfaceColor) we use the function 

Transpose, which was discussed in the above in-depth section. 

In[127]:= Show [Graphics3D [ 
Transpose[{Table[SurfaceColor[Hue[Random[]]], {lOa}], 

Cuboid /@ (2 a Table [ {Random [ ], Random [ ], Random [ ] } , 
{lOa}])}]], lmageSize-> 180]; 

• 3.4.3 Objects from Standard Packages 

Several standard packages collected in the Graphics directory contain tools to create 

graphics objects. We load the definitions using 

In[128]:= «Graphics' 
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• Arrows 

The Graphics' Arrow' package contains graphics objects for arrows. We can use them 
like this: 

In[129]:= Show[Graphics[{Arrow[{O, O}, {1, 1}], Arrow[{O, 1}, {1, O}]}], 
lmageSize -+ 160]; 

The documentation in the Help Browser explains the various options for changing arrow­

heads. 

In[130]:= Show[Graphics[{Arrow[{O, O}, {1, 1}, HeadLength-+O.l], 
Arrow[{O, 1}, {1, O}, BeadLength-+ 0.1, 

HeadCenter -+ O]}], lmageSize -+ 160]; 

• Polyhedra 

We find the definitions of polyhedra in the Graphics' Polyhedra' package. As an 

example, let us draw an icosahedron. 
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In[131]:= Show [Polyhedron [Icosahedron] , 
Boxed -> False, ImageSize -> 180] ; 

• Three-Dimensional Objects 

Part 3 

The Graphics' Shapes' package contains definitions for cylinders, cones, tori, sphere 

surfaces, etc., for use in Graphics3D objects. 

In[132]:= Show[Graphics3D[MoebiusStrip[3, 1, 50]], 
Boxed -> False, ImageSize -> 180]; 

There are also functions for rotating objects and for drawing grid models. 
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In[133]:= Show[Graphics3D[Sphere[1, 20, 20]], 
Boxed -> False, ImageSize -> 180] ; 

In[134]:= Show [WireFrame [Graphics3D[Sphere [1, 20, 20]]], 
Boxed -> False, ImageSize -> 180] ; 

• In Depth 

• Splines 

143 

Roughly speaking, spline functions approximate polygons with smooth polynomial curves. There are 

various ways of doing this, which you can select for each problem accordingly. Many spline versions 

are pre-defined in the Graphics' Spline' package. 

Let us look at a couple of points and the corresponding polygon. 

In[135]:= points = {{O, OJ, {O, l}, {l, l}, {2, 2}}; 
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In[136]:= Show [Graphics [{Hue [0], Line [points] }], ZmageSize -> 160]; 

A cubic interpolation is drawn using the following command: 

In[137]:= Show[Graphics[{Hue[O], Line [points] , 
GrayLeve1[0], Sp1ine[points, CUbic]}], J:mageSize -> 160]; 

• Exercises 

• The Pythagorean Theorem 

Draw a right-angled triangle and the three squares of the Pythagorean theorem on its sides. 

Hint: use AspectRatio, to scale the drawing properly. 

Color the squares differently. 

• The Thales Circle 

Draw a right-angled triangle and the corresponding Thales circle. 

Indicate the center of the circle with a small dot. 

In addition, draw a radius with an arrow. 

Label the sides of the triangle, the radius, and the circle. 

Part 3 
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• Tori 

The Torus function (from Graphics' Shapes') produces a long list of polygons. Throw out the 

first 40 elements of the list and look at the resulting object. 

Rotate the picture, so that you can see into the hole. 

Draw a grid model of it. 

Draw a torus with a 24xl2 grid. 

Drop the appropriate polygons from the list so that you get the torus with holes shown on the title 

page of Part I. 

If you double the number of polygons in every direction and color the surfaces, you get the title 

picture of the book. 

• Combining Objects 

Using Graphics' Shapes' draw a sphere and a long enough cylinder with half the radius of the 

sphere and its axis through the middle of the sphere. The result could look like this: 

Now use the TranslateShape function (from the package) to move the cylinder by one radius 

length in direction x. 

Draw a grid model of this object. 

• Boxes 

The title illustration to Part 4 consists of open "boxes" with five polygons making up the sides. It is 

quite easy to place such boxes on a virtual sphere by using a parametrization with spherical coordi­

nates. Try it. 
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• 3.5 Application: Animating a Mechanism 

Now we will use our knowledge to animate a simple plane mechanism. This consists of 

two rods (l and 4 units long) connected by a cylindrical joint. The short rod is supported 
by a cylindrical joint and rotates with a constant angular velocity. The long one slides on a 

horizontal plane. The support is 2 units above the horizontal plane. 

(If the graphics look jaggy on the screen, redraw them smoothly with Cell > Rerender 

Graphics.) 

1 

-, 
1 
1 
1 4 :2 

We want to vary the angle of rotation cpo 

If we place the origin of our coordinate system into the support, we can determine the 
coordinates of the rotating joint: 

In[138]:= joint[cp_] = {Cos[cp], Sin[cp]}; 

The sliding end of the long rod has the y coordinate - 2. The x coordinate is comprised of 

that of the joint and the horizontal side of the large right-angled triangle, which we calcu­

late using the Pythagorean theorem. 

I 

2' 
1 

1 

I 

4 
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In[139):= endPoint [Ip_] = {Cos[lp] +"16- (2+Sin[Ip])2, -2}; 

This allows us to define a function which yields, at a given angle ip, the graphics primitives 

for rendering both rods and a circle for the joint. 

In[140):= rods [Ip_] = 
{Disk[joint[Ip], .07], Line[{{O, O}, joint[Ip], endPoint[Ip]}]}; 

In[141):= Show [Graphics [rods [0]], 
AspectRatio -> Automatic, ImageSize -> 160]; 

Now we define a list of objects to illustrate the supports. They are fixed, therefore we do 

not need a function of ip. 

In[142):= supports = 
{Line [ { { - .2, -.3}, {O, O}, {. 2, -.3}}], Disk [ {O, O}, .07], 
GrayLevel [ . 5], Rectangle [ { - .3, -.3}, {. 3, -. 5} ] , 
Rectangle[{-l, -2}, {5, -2.2}]}; 

In[143):= Show [Graphics [supports], AspectRatio -> Automatic]; 

Now we are almost finished. We use Table to create a list of all the graphics and make 

sure that the same range is drawn for each angle. 
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In[144]:= Table [Show [Graphics [{supports, rods [cp] }] , 

PlotRange -+ {{ -1. 1, 5. 1}, {- 2 • 5, 1. 5} } , 
7r 7r 

AspectRatio -+ Automatic], {cp, 0, 2 7r - -, -}]; 
10 10 

Part 3 

This cell group can be closed in the notebook and animated with Cell> Animate Selected 

Graphics. 

The following command shows all the pictures of the "movie" overlapping: 

In[145]:= Show[%]; 

• Exercises 

• Sketches 

Create the three sketches of the mechanism from the above section. 
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• Parabola 

Animate the flight of a particle in a uniform gravitational field, neglecting the friction. 

Hint: If the flight starts at the origin with an initial velocity Va, the initial angle is a, and the accelera-

tion of gravity g, then the x and y coordinates at time t are given by x=vat(cosa) and 
• g (2 

Y = Va t(sma) - """l .. 

The notebook contains a simple solution: 

Superimpose a plot of the corresponding parabola. 

Here is a possible solution for this as well: 

• Cycloids 

A wheel rolls on a horizontal surface. At half radius a point is marked on the wheel. As the wheel 

moves this indicates a (shortened) cycloid. Visualize the wheel and the curve. 

A static picture could look like this: 

The notebook contains a suggestion for the animation: 

This gives you a starting point for animations of more generalized cycloids. 



Part 4: Introduction to 
Programming 

Part 4 discusses in greater detail how Mathematica works, so that we can tailor our 
calculations and develop simple programs. To do this, we need to understand the internal 

representation of expressions and know how patterns are used in definitions and transforma­

tion rules. 

We will see that Mathematica contains all the tools for the well-known procedural program­

ming styles in languages like Pascal, Modula-2, C, or Fortran, but that many problems can 

be solved much simpler using functional or rule-based programming. 

The conclusion contains links to literature and to programs available on the World Wide 

Web. 

S. Kaufmann, A Crash Course in  Mathematica
© Birkhäuser Verlag 1999
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• 4.1 Expressions 

Mathematica works internally with a uniform representation of all objects as expressions. 

Even entire notebooks are expressions and can be programmed accordingly (see Section 

2.10.3 of the Mathematica Book). Numbers, names, and strings are atomic expressions. 

Nonatomic expressions have the form f [aI' a2' ... J. The name f denotes the head, and 

zero or more arguments aI, a2, ... are placed in square brackets. The arguments are 

themselves expressions. 

The function FullForm shows the representation as an expressions. With 

In[1]:= FullForm [f [x] ] 

Out[1]IIFuliForm= 

f[x] 

nothing sensational happens, because f [x 1 was already written as an expression. More 

interesting is: 

In[2]:= FullForm[ (a + b) An] 

Out[2]IIFuliForm= 

Power [Plus [a, b], n] 

Here we see that a + b is written internally as Plus [a, bland the power with Power. An 

alternative view is produced by TreeForm, which displays the hierarchical structure as a 

tree. 

In[3]:= TreeForm[ (a + b) An] 

Out[3]/lTreeForm= 

Power [ I , nl 
Plus [a, b] 

We see that the first argument of Power is itself a nonatomic expression (that is 

Plus [a, b]); the vertical line I indicates the next level in the hierarchy. The second 

argument of Power is atomic. 

Somewhat more complicated is: 
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In[4]:= TreeForm[{a, (a A2 -b) An}] 

Out[4VfTreeForm= 

List[a, 

Power [ 

Plus [ I 
Power [a, 2] Times[-l, b] 

] 
, n] 
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This internal representation of expressions is important with many problems (see in­

depth). Mathematica uses it in all calculations, especially in pattern recognition. 

Many functions which we know from list manipulation also work for expressions. Have a 

look at: 

In[5]:= expr = 1 + x + X A 2 

Out[5]= 1 + x + x 2 

In[6]:= FullForm [expr] 

Out[6]1/FuIiForm= 

Plus[l, x, Power [x, 2]] 

The first part (the first argument of the outer expression) is 

In[7]:= expr [ [1]] 

Out[7]= 1 

the second part is 

In[8]:= expr [ [2]] 

Out[8]= x 

We can easily add a further element using Append: 

In[9]:= Append [expr, x A 3] 

Out[9]= 1 + x + x 2 + x 3 

• In Depth 

• Patterns for Rational and Complex Numbers 

For rational numbers Mathematica uses a representation with Rational: 
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In[10]:= FullForm[3/ 4] 

Oul[10VlFuIiForm= 

Rationai[3, 4] 

Part 4 

To determine the numerator and the denominator of a rational number and combine the two as a list, 

we write: 

In[ll]:= numAndDen[Rational[a_, b_]] = {a, b} 

OUI[ll]= {a, b} 

In[12]:= numAndDen [3 / 4] 

Oul[12]= {3, 4} 

The following version does not work: 

Oul[13]= (a, b) 

In[14]:= wrong [3 /4] 

OUI[14]= wrong [ f 1 

because the expression wrong [Rational [3,4]] is not matched by the pattern in the definition: 

In[15]:= FullForm[wrong[a_/b_]] 

Out[15]IIFuIiForm= 

wrong [Times [Pattern[a, Biank[]], Power [Pattern[b, Biank[]], -1]]] 

We see this more clearly without the blanks: 

In[16]:= FullForm[wrong[a / b]] 

Out[16]IIFuIiForm= 

wrong[Times[a, Power[b, -1]]] 

In the same way, complex numbers are written internally using Complex: 

In[17]:= FullForm[2 + 3 :1:] 

Out[l7]IIFuIiForm= 

Compiex[2, 3] 

• Exercises 

• The Structure of Expressions 

Study the internal representations of the following expressions: 
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x' [t] 

D[s [x, y], x, y] 

• Real and Imaginary Parts 

Study the above in-depth section. Using pattern recognition, define a function which returns the real 
and imaginary parts of a complex number as a list. (Do not use Re or rm.) 

• 4.2 Patterns 

We have already seen in the first part that the left-hand side of transformation rules and 

definitions must be interpreted as patterns. The patterns generally contain blanks C) 
which can be filled with any expression. So a pattern matches an expression if the expres­

sion has exactly the same structure as the pattern (in the internal representation), but any 

sub-expressions can appear instead of blanks in the pattern. 

There are various useful tools to restrict patterns or construct more complicated patterns. 

• 4.2.1 Simple Patterns 

Let us look at the following expression: 

In[18]:= formula = 1 + x + X A 2 + Y A 3 + Z A 2 + X A 2 Sin [z] 

Out[18]= 1 + x + x 2 + y3 + Z2 + x 2 Sin [z] 

We can substitute values with the help of transformation rules. 

In[19]:= formula /. x - > 3 

Out[19]= 13 + y3 + Z2 + 9 Sin [z] 

The left-hand side of the transformation rule, i.e. x, is in this case a very special pattern. It 

only matches the expression x. If we replace x with a Blank C), this pattern matches the 

entire formula and everything is replaced by the right-hand side of the transformation rule. 
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In[20):= formula /. -> 3 

Out[20)= 3 

It gets more interesting if we use a_A 2 pattern to set all squares to zero. 

In[21):= formula /. _" 2 -> 0 

Out[21)= 1 + x + y3 

Or we can make all powers disappear: 

In[22):= formula /. _" _ -> 0 

Out[22)= 1 + x 

Or we can rewrite a sum of two squares in a new form: 

In[23):= formula / • a_ "2 + b_ "2 -> sumOfSquares [a, b] 

Out[23)= 1 +X+y3 +X2 Sin[z] + sumOfSquares[x, z] 

The use of patterns in definitions is completely analogous. For example, we can extract the 

coefficients of a linear polynomial as a list: 

In[24):= coeffs [a_ + b_ x_, x_] = {a, b}; 

In[2S):= coeffs [1 + 2 y, y] 

Out[25)= { 1, 2} 

If an expression is not matched by the pattern, it will not be evaluated. 

In[26):= coeffs [1 + 2 x +, y" 2, y] 

Out[26)= coeffs [1 + 2 x + 4 y2, y] 

In order to really be useful, the above definition must be improved. In the following cases 

it does not work like we want it to: 

In[27]:= coeffs [2 y, y] 

Out[27)= coeffs [2 y, y] 

(The expression is not matched by the pattern because there is no constant summand.) 
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In[28]:= coeffs [1 + y, y] 

Out[28]= coeffs [1 + y, y] 

(The expression is not matched by the pattern because there is no factor in the linear term.) 

In[29]:= coeffs[1+2y+y"2, y] 

Out[29]= {1 + y2, 2} 

(1+y"2 is matched by the a_ of the pattern.) 

Luckily there are simple tools to handle such cases. They will be discussed in the next two 

sections. 

• 4.2.2 Constraints 

There are three ways of defining patterns that only match under constraints: 

• fixing the "type" (head) of the expression, 

• constraints with / ; operators, 

• constraints with test functions. 

• Constraints on Heads 

We have seen that each expression has a head, which can be interpreted as the type of the 

expression. 

The function Head shows that even atomic expressions have heads which are normally 

hidden: 

In[30]:= Head /@ {a, "x", 1, l.l} 

Out[30]= {Symbol, String, Integer, Real} 

The head of a list is Lis t. 

In[31]:= Head[{a, b}] 

Out[31]= List 

A blank followed by the name of the desired head only matches expressions with that head. 
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As an example for this technique, let us look at a function which returns the first element 

of a list. (For this we need a delayed definition because the right-hand side can only be 

evaluated once the list has been inserted.) 

In[32]:= firstElement [1_] : = 1 [1] 

In[33]:= firstElement [{a, b, c}] 

Out[33]= a 

This definition produces an error message if we apply it to an atomic expression. 

In[34]:= firstElement [1] 

Part: :partd : 
Part specification 1[1] is longer than depth of object. 

Out[34]= 1 [1] 

The following improved version restricts the pattern to arguments of type List. It will 
avoid the error messages: 

In[35]:= Clear [firstElement] 

In[36]:= firstElement [l_List] : = 1 [1] 

In[37]:= firstElement [{a, b, c}] 

Out[37]= a 

In[38]:= firstElement [1] 

Out[38]= firstElement [1) 

• Constraints with I; 

With the operator / ; constraints can be applied to the pattern itself or to the entire defini­

tion. On the right-hand side of the operator there must be a test which yields the result 

True for those expressions which should be matched by the pattern. 

This gives us a function which only evaluates positive arguments: 

In[39]:= numRoot [x_] : = ~ /; x ~ 0 

In[40]:= numRoot [2 ] 

Out[40]= 1. 41421 
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In[41]:= nwnRoot [-1] 

OUI[41]= numRoot [ -1] 

The alternative version, in which the constraint is placed directly into the pattern for the 

arguments, works just as well. 

In[42]:= nwnRoot2 [x_ /; x ~ 0] : = ~ 

In[43]:= nwnRoot2 /@ {2, -I} 

Out[43]= {1.41421, numRoot2 [-1]} 

The following example can only be defined using a constraint on the definition: 

In[44]:= rootOfSum[x_, y_] : = -{N[X + y] /; x + y ~ 0 

In[45]:= rootOfSum[S, -2] 

Out[45]= 1. 73205 

In[46]:= rootOfSum [ - 5, 2] 

Out[46]= rootOfSum[ -5, 2] 

We can also create piecewise functions with this kind of constraint. 

In[47]:= piecewise [x_] : = x 2 /; x > 0 

In[48]:= piecewise [x_] : = -x /; X :s 0 

In[49]:= Plot [piecewise [x], {x, -1, I}]; 

1 

0.8 

0.6 

0.4 

-1 -0.5 0.5 1 
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Derivatives and integrals of functions which were defined in this way cannot be evaluated. 

For such tasks it is preferable to use the function Uni tStep, which in Version 3.0.x is in 

the Calculus' DiracDel ta' package and will be built into the kernel in future 

versions . 

• Test Functions 

Mathematica contains a great number of test functions which are useful for constraints on 

patterns. Their name always ends with Q. They result in True if the test has been success­
ful or in False in all other cases: if the test has been unsuccessful or if the result is 

undetermined. The following command lists all test functions: 

In[50]:= ? *Q 

ArgumentCountQ 
AtomQ 
DigitQ 
EllipticNomeQ 
EvenQ 
ExactNumberQ 
FreeQ 
HypergeometricPFQ 
InexactNumberQ 
IntegerQ 
IntervalMemberQ 
InverseEllipticNomeQ 
LegendreQ 
LetterQ 
LinkConnectedQ 
LinkReadyQ 
ListQ 
LowerCaseQ 
MachineNumberQ 
MatchLocalNameQ 
MatchQ 

MatrixQ 
MemberQ 
NameQ 
NumberQ 
NumericQ 
OddQ 
OptionQ 
OrderedQ 
PartitionsQ 
PolynomialQ 
primeQ 
SameQ 
StringMatchQ 
StringQ 
SyntaxQ 
TrueQ 
UnsameQ 
upperCaseQ 
ValueQ 
VectorQ 

The functions Positive, Negative, and NonNegative are also useful. However, 

they may remain unevaluated: 

In[51]:= positive/@{-l, 0,1, a} 

Out[51]= {False, False, True, Positive [aJ } 

Using TrueQ we can create test functions which in such a case give a False: 

In[52]:= myPositiveQ [x_l : = TrueQ [Positive [xll 

In[53]:= myPositiveQ /@ {-1, 0, 1, a} 

Out[53]= {False, False, True, False} 
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With the function FreeQ, which tests if an expression contains a symbol, we can rule out 

in the above definition of coeffs that the "constant summand" contains a higher power 

of x. We must first clear the old definition, which would otherwise remain active, and use 

a delayed definition, so that the test is evaluated correctly. 

In[54]:= Clear [coef f s] 

In[55]:= coeffs [a_ + b_ x_, x_I : = {a, b} /; FreeQ [a, x] 

In[56]:= coeffs [1 + 2 y + y2, y] 

Out[56]= coeffs [1 + 2 y + y2 , y] 

• Constraints Using Test Functions 

Patterns can also be constrained using (pure) test functions. For this we use the form 

pattern? test. The test function is then applied to the argument and the pattern matches 

only if the test function returns True. With EvenQ we restrict the arguments to be even: 

In[57]:= half [n_? EvenQ] = n / 2; 

In[58]:= half /@ {I, 2} 

Out[58]= {half [1] ,I} 

We can define our own test functions, preferably as pure functions. The following defini­

tion tests whether the argument is a non-negative integer. 

In[59]:= myFactoriall [n_? (# ~ 0 &:&: IntegerQ [#] &:)] = n ! ; 

In[60]:= myFactoriall /@ {-I, 1 / 2, 10} 

Out[60]= {myFactoriall [-1], myFactoriall [ ~ l, 3628800} 

An alternative would be: 

In[61]:= myFactorial2 [n_? (NonNegative [I] &:&: IntegerQ [I] &:)] = n ! ; 

In[62]:= myFactorial2 /@ {-I, 1/2, 10} 

Out[62]= {mYFactoria12 [ -1] , myFactoria12 [ ~-l, 3628800} 
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• 4.2.3 More Complicated Patterns 

There are several methods to create even more complicated patterns (see Section 2.3.6 ff of 

the Mathematica Book). We will only discuss the most important ones here. 

• Alternatives 

With I we can combine different patterns. 

In[63]:= x + x"2 + x"3 + y I. x I x" -> C 

QUI[63]= 3 c + y 

• Optional Arguments and Default Values 

The following function adds its two arguments: 

In[64]:= add [x_, y _] = x + y; 

In[65]:= add [a, b) 

Qul[65]= a + b 

In case of only one argument, the pattern will not match and therefore nothing happens. 

In[66]:= add [a] 

Qul[66]= add [ a 1 

But perhaps in such a case the argument itself should be returned. We obtain this by 

entering a default value after a colon. The default value is then used if the argument is 

missing. 

In[67]:= Clear [add] 

In[68]:= add[x_, y_: 0] = x + y; 

In[69]:= add [a, b) 

QUI[69]= a + b 

In[70]:= add [a] 

QUI[70]= a 
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For sums, products, and powers the default values 0, 1, and 1 are already built in; an 

optional argument is defined by placing a dot behind the blank. In this way we can create 
an improved variation of our coeffs function: 

In[71]:= Clear [ coef f s 1 

In[72]:= coeffs [a __ + b __ x_, x_l : = {a, b} /; FreeQ [a, xl 

A missing constant summand is now replaced by 0 and a missing coefficient in the linear 

term is replaced by 1. 

In[73]:= coeffs [x, xl 

Out[73]= { 0, l} 

• 4.2.4 A Simple Integrator 

Because Mathematica's evaluation process basically uses all definitions and rewrites the 

result until nothing more changes, we can easily create programs that can solve rather 

complicated tasks. 

An an example, we program our own integration function for simple polynomial expres­

sions (see Section 2.3.14 of the Mathematica Book). We call the function toyInte­

grate. Just as with Integrate we suppose that the expression to be integrated is 

entered as the first argument and the variable as the second. 

Linearity is treated by two definitions. The integral of a sum is the sum of the integrals: 

In[74]:= toylntegrate [y_ + z_, x_l : = 
toylntegrate [y, xl + toylntegrate [z, xl 

Constants (which do not contain the function variables) can be drawn before the integral. 

In[75]:= toylntegrate [c_y_, x_l : = c toylntegrate [y, xl /; FreeQ [c, xl 

The integral of a constant is: 

In[76]:= toylntegrate [c_, x_l : = c x /; FreeQ [c, xl 

The integral of an integer power, except -1, can be processed using: 

X D +1 

In[77]:= toylntegrate[x_n_., x_l := -- /; FreeQ[n, xl &:&:n f.-1 
n+1 
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These four definitions already do an amazing job. 

1 
In[78]:= toyIntegrate [ a x 2 + b x + C + --, x] 

x 

Qul[78]= 
bx2 a x 3 1 

ex + -2- + -3- + toylntegrate [ x' xl 

Part 4 

The integral of + cannot yet be determined. Nonetheless, the rest is automatically calcu­

lated as completely as possible. 

With the additional definition 

1 
In[79]:= toyIntegrate [------, x_] : = 

a_o x_ + b_ 

Log[ax+b] 
------ /; FreeQ[{a, b}, x] 

a 

we come one step further: 

1 
In[80]:= toyIntegrate [ a x 2 + b x + c + -, x] 

x 

b x 2 a x 3 
Qul[80]= C x + -2- + -3- + Log [x 1 

The integrator in Version 1 of Mathematica was built up in this way, but since Version 2 it 

has been replaced by a much better algorithm . 

• In Depth 

• Patterns of Derivatives 

Derivatives have the following representation as Mathematica expressions: 

In[81]:= FullForm[x' [tll 

Qul[81]IIFuIiForm= 

Derivative[1] [x] [t] 

Because there is no x [ t 1 in this expression (note the different bracketing), a transformation rule 
containing the pattern x [ t] will not match derivatives. Such a rule is produced when solving a 
differential equation for x [ t] . 

In[82]:= DSolve [x' [tj == x [tj, x [tl, tj 

QUI[82]= ({x [t] --7 Et C [1])) 
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In[83]:= x' [t] /. % [ [1]] 

Out[83]= x' [t] 

If we request the solution as a pure function, i.e. as a transformation rule for x itself, the pattern does 

match. 

In[84]:= DSolve [x' [t] == x [t], x, t] 

Out[84]= {{x--> (E#1 C[l] &)}} 

In[85]:= x' [t] /. %[ [1]] 

Out[85]= Et C [1] 

In this way we can verify the solution. 

In[86]:= x' [t] == x [t] /. %% [ [1]] 

Out[86]= True 

• Several Arguments 

Sometimes an unknown number of arguments should be processed, for instance in programming 
functions with options. Two blanks (_) stand for one or more arguments, three blanks ( __ ) also 

include the case of no argument at all. 

To illustrate this, let us look at a function that returns its arguments as a list. The list can also be 

empty, so we use three blanks: 

In[87]:= listOfArguments[x __ ] = {x} 

Out[87]= { x} 

In[88]:= 1istOfArguments [] 

Out[88]= {} 

In[89]:= listOfArguments[a, b, c] 

Out[89]= (a, b, c) 

• Functions with Options 

Now we want to develop the skeleton of a function with options. We call it skel. It shall have one 

argument and two options optl and opt2. To illustrate what is going on, the result shall be a list, 

consisting of the argument and the values of the two options. 

The default values of the options shall be defaul tl and defaul t2. If the user does not set an 

option, the default value will be used. It is a convention in Mathematica that the list of default values 

of options is passed to the built-in function Options in the following way: 

In[90):= Options[skel] = {opt1 ... default1, opt2 ... default2}; 
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Now we can detennine the default value of optl: 

In[91]:= opt1 /. Options[skel] 

Out[91]= defaul tl 

Because several / . operators are evaluated from left to right, in the following expression the option 

optl is fIrst set to 3. Then the list of default values is applied to the result. However, this no longer 

has an effect on optl, because it was already substituted by 3 before. 

In[92]:= opt1 /. opt1 ... 3/. Options [skel] 

Out[92]= 3 

In this way the skel function can easily be defIned: 

In[93]:= skel[x_, opts __ ] := {x, optl, opt2} /. {opts} /. Options[skel] 

If no option values are given, the defaults are used: 

In[94]:= skel [a] 

Out[94]= fa, defaultl, default2} 

But given options will be used: 

In[95]:= skel [a, opt2 ... myValue2] 

Out[95]= {a, defaultl, myValue2} 

Let us slightly improve the defInition of skel. With the test function OptionQ we make sure that 
options (transformation rules) have actually been given. We also make sure it all works if the options 
are given as a list. The skeleton then finally looks like this: 

In[96]:= Clear [skel] 

In[97]:= skel[x_, opts __ ?OptionQ] := 
{x, opt1, opt2} I. Flatten [ {opts}] /. Options [skel] 

In[98]:= skel [a] 

Out[98]= {a, defaultl, default2} 

In[99]:= skel[a, a] 

Out[99]= skel [a, a] 

In[100]:= skel [a, {opt1 -> myValue1, opt2 -> lI\Y'Value2}] 

Out[100]= fa, myValuel, mYValue2} 

Of course, this function does not do anything useful yet. In practice, the option values given by the 

user will probably be detennined in a module, and the evaluation will be continued according to 
these values. 
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• Exercises 

• Gradients 

Enhance the function gradient from the exercises to Section 3.2 so that it only evaluates if a list is 
entered as the second argument. 

• Dot and Cross Products 

Enhance the functions defined in the exercises to Section 3.2 for the calculation of dot and cross 
products, so that they are only evaluated for suitable inputs. 

• Integrator 

Enhance the integrator of Section 4.2.4 with a couple of additional definitions, for instance, to handle 
trigonometric functions. 

The integration process can be illustrated using Print commands, so that whenever a definition is 

used a corresponding message is written. Put the right-hand side of the definition into parentheses, 

creating a compound expression: 

toy:Integrate[y_ + z_, x_l : = (Print [nSum rule for n, y, n and n, z]; 
toy:Integrate[y, xl + toy:Integrate[z, xl) 

Use this method to enhance the definitions for toyIntegrate. Observe the evaluation of some 

examples. 

The function can be improved even further by adding an option for switching messages on and off 
(see the above in-depth section). Branching with If is useful here. 

• 4.3 Evaluation 

With this previous knowledge we can learn how Mathematica actually works. This will 

help us to single-mindedly develop our calculations and to understand why Mathematica 

sometimes returns unexpected results. 

We begin with preliminaries about associated definitions and definitions with attributes 

and then observe the evaluation process of expressions 

• 4.3.1 Associated Definitions 

Definitions are normally associated to the outermost head of the pattern. As necessary, 

they can also be associated with a head of an argument. This can be used to add properties 

of built-in functions. 
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We may wish to define the integral our own function myFunction: 

In[101]:= Integrate [myFunction [x_l, x_l = integralOfMyFunction [xl 

Set::write: Tag Integrate in fmYFUnctiOn[X_l dx_ is Protected. 

Out[101]= integralOfMyFunction [xl 

This does not work because the internal function Integrate is protected (by the 

attribute Protected). 

(In principle, we could remove the protection of Integrate with Unprotect and then 

use the above definition. However this is very dangerous; an incorrect definition may 

render the integrator useless.) 

But because the definition applies only to our function anyway, we can associate to it 

using the I : operator: 

In[102]:::: myFunction /: Integrate [myFunction [x_l , x_l = 
integralOfMyFunction[xl 

Out[102]= integralOfMyFunction [xl 

In[103]:= Integrate [myFunction[yl, yl 

Out[103]= integralOfMyFunction [y] 

A short form is "= (and" : = for an associated, delayed definition): 

In[104]:= Integrate [yourFunction [x_l, x_l A = integralOfYourFunction [xl 

Out[104]= integralOfYourFunction [xl 

• 4.3.2 Attributes 

Functions can also have attributes assigned to them in order to determine properties such 

as associativity, commutativity, or automatic mapping on lists. A complete list of all 

possible attributes can be found in the documentation to Attributes. This function 

shows us that Sin carries the attribute Listable. 

In[105]:= Attributes [Sinl 

Out[105]= {Listable, NumericFunction, Protected} 
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As a consequence Sin is mapped automatically on the elements of lists. 

In[106):= Sin[{O, Pi/4, Pi/2}] 

Out[106)= {o, ~, 1} 

Our own functions do not behave this way. 

In[107):= isNotMapped [ {O, Pi / 4, Pi / 2} ] 

Out[107)= isNotMapped [ {o, ~, ;} 1 

In[108):= Attributes [iSNotMapped] 

Out[108)= { } 

But we can assign the attribute Listable to define a function which is automatically 

mapped on lists: 

In[109):= SetAttributes [isMaPped, Listable] 

In[110):= isMapped[ {O, Pi / 4, pi /2}] 

Out[110)= {isMapped[O] , iSMapped[ ~ l, iSMapped[; l} 

In[111):= Attributes [isMapped] 

Out[111)= {Listable} 

• 4.3.3 The Evaluation Process 

Mathematica's evaluation process can be divided into three phases: 
1. Reading the cell and transforming it into the internal representation as an expression. 

2. Evaluating the expression. 

3. Formatting the result for output. 

Only the second step is of interest to us. Here all built-in and user-defined transformation 

rules and definitions are used to rewrite the expression, until nothing more changes. 

Mathematica does this in the following order: 

2.1 Evaluation of the head. 

2.2 Evaluation of each argument, in order. 

2.3 Re-ordering using the attributes Flat (associative) and Orderless (commutative). 
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2.4 Mapping to lists (attribute Listable). 

2.5 Application of user-defined definitions associated to the head of an argument. 

2.6 Application of built-in definitions associated to the head of an argument. 

2.7 Application of user-defined definitions associated to the head of the expression. 

2.8 Application of built-in definitions associated to the head of the expression. 

Part 4 

Through pattern recognition, the steps 2.5-2.8 are used to test whether the pattern of a rule 

or definition matches. If it does, the right-hand side of the definition is substituted and the 

evaluation restarts for the new expression. 

After the evaluation of the head, step 2.2 of this process introduces a recursion, thereby 

finally evaluating the expression from the inside out. The recursion comes to an end in 

every branch of the tree (TreeForm) when atoms are reached: numbers, strings, and 

symbols without definitions evaluate to themselves; for a symbol with definitions, the 

right -hand side of the definition is evaluated in step 2.7. 

This standard evaluation scheme can be changed (see Section 2.5.5 of the Mathematica 

Book), and several built-in functions must deviate from this in order to function properly. 

We will, however, not go into this further here. 

Trace lists each step in the evaluation: 

In[112]:= testFunction[x_ 1 Y_] := simplify[x"2 -y"2] 

In[113]:= someName = testFunction; 

In[114]:= Trace [someName [Expand [ (a + a + b) "2] I a]] 

Out[114]= {{sorneNarne, testFunction}, 

{ { { a + a + b, 2 a + b}, (2 a + b) 2 }, Expand [ (2 a + b) 2 j , 

4a2 +4ab+b2 }, testFunction[4a2 +4ab+b2 , aj, 

Sirnplify[(4a2 +4ab+b2 )2 _a2], 

{ (4 a 2 + 4 a b + b 2 ) 2 - a 2 , _a2 + (4 a 2 + 4 a b + b2 ) 2 } , 

Sirnplify[-a2 + (4a2 +4ab+b2 )2], _a2 + (2a+b)4} 

We see how first the head someName evaluates to testFunction. The evaluation of 

the first argument begins with the evaluation of the argument of Expand, then Expand 

itself is applied. Next, the definition for testFunction is used and its right-hand side is 

evaluated. 
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• In Depth 

• Delayed Transformation Rules 

In addition to the (immediate) transformation rules with - > or ~ Mathematica also recognizes 
delayed ones. They are written as : > or :~. As with delayed definitions, the right-hand side is only 

evaluated after the pattern has been replaced. 

In[115]:= {a+b)2/.x_ .... Expand[x] 

Out[115]= (a + b) 2 

In[116]:= {a+b)2 /. x_>+Expand[x] 

Out[116]= a 2 + 2 a b + b 2 

One can therefore understand an immediate definition to be a global immediate transformation rule, 

and a delayed definition to be a global delayed transformation rule. 

• Repeated Application of Transformation Rules 

A transformation rule is applied only once using / .. For repeated application until nothing more 

changes, we use the / / . operator. The difference is made clear in the following two expressions 

(see also Section 4.4.3). 

In[117]:= fac[5]/. {fac[O]->l, fac[n_]->nfac[n-l]} 

Out[117]= 5 fac[4] 

In[118]:= fac[5]//. {fac[O]->l, fac[n_]->nfac[n-l]} 

Out[118]= 120 

• Hold 

We cannot see an expression such as 1+1 in its full form at first, because according to the evaluation 
process in a 

In[119]:= FullForm[l + 1] 

Out[119]IIFuIiForm= 

2 

the argument will be evaluated before FullForm is applied. For this the functions Hold and 

HoldForm are useful. They prevent the evaluation of their arguments: 

In[120]:= Hold[FullForm[l + 1]] 

Out[120]= Hold[Plus[l, 1]] 

In[121]:= HoldForm[Fulll'orm[l + 1]] 

Out[121]= Plus [1, 1] 
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• Exercises 

• The Attribute Orderless 

Study the documentation of the attribute Orderless and then interpret the evaluation of the 
following function: 

SetAttributes[pr, Orderless] 

pr[x_] := 1 I; Print[x] 

pr[l, 2, 3] 

• Application of Transformation Rules: Fibonacci Numbers 

Fibonacci numbers can be calculated recursively: The zeroth is 0 and the first is I, higher ones are 
the sum of the previous two. Use transformation rules to determine the tenth Fibonacci number. 

(This works only for small numbers, because the number of calculations needed grows exponen­
tially. See Section 4.4.3.) 

• 4.4 Programming Tools 

We will now have a look at the most important tools for programming. This will show us 

that it is possible to program using different methodologies. Often the well-known proce­

dural style, used in C, Fortran, or Pascal, is not the clearest nor the most efficient for 

Mathematica. 

• 4.4.1 Local Variables 

If programs are to be given to users there lies the danger of collision between the names in 

the program and the names chosen by its user. There are two mechanisms for avoiding 

such name collisions in Mathematica. On the procedural or functional level, the Module 

mechanism is used to define local variables. The technique used on a global level, espe­

cially for the names of the functions themselves, will be discussed in Section 4.4.5. 

The Module function has two arguments. The first is a list of local variables, the second a 

possibly compound expression (a series of single expressions divided by semicolons). 

Against intuition, commas divide more strongly than semicolons. 
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The following function calculates the rotation of a planar vector by an angle cpo It makes 
sense to avoid multiple calculations of trigonometric functions, because this is time­

intensive. With the help of two local variables, we can write: 

In[122]:= rot2D[ {x_, y_}, Ip_] : = 
Module [{sinlp, COSIp}, 

sinlp = Sin[Ip]; 
COSIp = Cos [Ip] ; 
{{COSIp, -sinlp}, {sinlp, COSIp}}.{x, y} 

In[123]:= rot2D[ {1, 1}, Pi / 2] 

Out[123]= {-1, 1} 

The local variables can be initialized as they are introduced by using immediate defini­

tions. This gives us a more compact implementation. 

In[124]:= rot2D[ {x_, y_}, Ip_] : = Module [{sinlp = Sin[Ip], COSIp = Cos [Ip]}, 
{{COSIp, -sinlp}, {sinlp, COSIp}}.{x, y}] 

If the result of a Module function is not calculated at the end of the module, it can be 

returned using Return. 

The related functions Wi th and Block will not be discussed here . 

• 4.4.2 Functional Programming 

Mathematica is predestined for functional programming. This means the nesting of 
functions, as we have done a lot of times without thinking about it. Let us look at a class of 

problems which are well-suited as examples for functional programming. 

Many nonlinear algorithms can be reduced to the search for fixed points of mappings. One 

starts at any initial point and applies the mapping. The same mapping is again applied to 

the result. And so on, until the difference between two successive results is within a 

chosen threshold. 

A good example is Newton's algorithm for finding roots of functions. We consider a 

function of one variable and begin with an initial x value. At this point we draw the 

tangent to the graph and determine its intersection with the x axis. This gives us the first 

approximation of the root. 

Let us choose the function 
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In[125]:= f [x_] = Cos [x2 ] - Sin [x] ; 

In[126]:= Plot [f [x] I {x, 0, 2}]; 

1.5 2 

-1 

-1. 5 

-2 

as an example. We need its derivative. 

In[127]:= df [x_] = ax f [x] 

Out[127]= -Cos [x] - 2 x Sin [x2 ] 

The initial value shall be xo=1.6. The tangent therefore looks like this: 

2 

The intersection with the abscissa calculates as Xo - :~~»' The corresponding pure 

function is: 

In[128]:= # - f [I] / df [I] &: 

f[#1] 
Out[128]= #1 - df [#1] & 

Applied to the initial value, it yields: 

In[129]:= # - f [I] / df [I] &: [1. 6] 

Out[129]= 0.538438 
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With this value the same procedure is repeated to determine the second approximation of 

the root. With the exception of pathological cases (horizontal tangents, limit cycles) we 

very quickly arrive at a good approximation of the root. The Mathematica function Nest 

is very helpful for this process: 

In[130):= Nest [g, x, 5] 

Out[130)= g[g[g[g[g[x]]]]] 

NestList can be used to see the intermediate results as well: 

In[131):= NestList [g, x, 3] 

Out[131)= {x, g[x], g[g[x]], g[g[g[x]]]} 

In place of g we simply have to use our pure function-and the program is finished. 

In[132):= NestList[l-f[l] Idf[l] &:,1.6,5] 

Out[132)= {lo6, 0.538438, 0.920372, 0.853035, 0.849379, 0.849369} 

The nesting functions FixedPointList and FixedPoint work until two successive 

results agree (within a built-in threshold defined by SameQ): 

In[133):= FixedPointList [I - f [I] I df [I] &:, 1.6] 

Out[133)= {lo6, 0.538438, 0.920372, 0.853035, 

0.849379, 0.849369, 0.849369, 0.849369} 

In[134):= FixedPoint [I - f [I] I df [I] &:, 1.6] 

Out[134)= 0.849369 

(In Mathematica 4, the functions NestWhile and NestWhileList give you extended 

control over the tests used to terminate the nesting.) 

By using local variables, we could program Newton's algorithm as follows: 

In[135):= Clear[f, df] 

In[136):= myNewton[f_, {x_, xO_}]:= 
f 

Module [{df = Bx f}, FixedPoint [11 - - I. x -+ 11 &:, N[XO]]] 
df 

In[137):= myNewton [Cos [x2 ] - Sin [x], {x, 1.6}] 

Out[137)= 0.849369 
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The functions FoldList, Maplndexed, and ComposeList are also helpful in 

functional programs. They allow iterations over lists: 

In[138]:= Fo1dList [f, x, {a, b, c}] 

Out[138]= { x , f [x, a], f [ f [x, a] , b], f [ f [ f [x, a] , b], c]} 

In[139]:= Mapl:ndexed[f, {a, b, c}] 

Out[139]= { f [a, {1}], f [b, {2}], f [ c, {3}]} 

In[140]:= ComposeList [{f1, f2, f3}, x] 

Out[140]= {x, f1 [x], f2 [f1 [x]], f3 [f2 [f1 [x]]] } 

• 4.4.3 Rule-Based and Recursive Programming 

We saw a good example of rule-based programming in the integrator of Section 4.2.4. 

This is done by listing definitions for appropriate patterns. Mathematica automatically 

sorts them so that the specific ones are applied before the general. This allows the follow­

ing recursive program for the factorial function: 

In[141]:= IlliYFactoria1 [n_l:nteger?NOnNegative] : = n:m;yFactoria1 [n - 1] 

In[142]:= :m;yFactoria1 [0] = 1; 

In[143]:= :m;yFactoria1 [10] 

Out[143]= 3628800 

The command 

In[144]:= ? :m;yFactoria1 

Global'myFactorial 

myFactorial[O] = 1 

myFactorial[ (n_Integer) ?NonNegative] := n*myFactorial[n - 1] 

shows us the order in which the definitions are applied by Mathematica. We see that they 

are ordered such that the more specific definition is used before the more general one. This 

assures that the end condition is reached-and the algorithm terminates. 

Large recursions can trigger an internal security limit. 
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In[145]:= myFactorial [300] 

$RecursionLimit::reclim: Recursion depth of 256 exceeded. 

Out[145]= 55620303071452811798215751307555657018384271133 6512 883 7003 95 ", 
15243292095283955303008059152370574723282623082366303381970' 
97829634401443145981610309370148732792447898675081845435004' 
24469331618247148406583202183019314395508496150245243330615' 
37654094389547013509047896956485425752519329094929190213993' 
58043611711050489276742955535958345570224000114013025111650' 
11731788110884032719420438135630831167687120808957899431632' 
86505839081435386529923870798034282426460016036787055842956' 
77731123611698200576000000000000000000000000000000000000000' 
0000000000000000000000000myFactorial[46] 

If the recursion will terminate for sure, the limit can be enlarged (or even set to Inf in­

i ty) by changing the global variable $RecursionLimi t. 

In[146]:= $RecursionLimit = 10" 3; 

In[147]:= myFactorial [300] 

Out[147]= 306057512216440636035370461297268629388588804173 57 699941677 6 ", 
74125947653317671686746551529142247757334993914788870172636~ 

88642639077590031542268429279069745598412254769302719546040~ 

08012215776252176854255965356903506788725264321896264299365~ 

20457644883038890975394348962543605322598077652127082243763~ 

94491201286786753683057122936819436499564604981664502277165~ 

00185176546469340112226034729724066333258583506870150169794~ 

16885035375213755491028912640715715483028228493795263658014~ 

52352331569364822334367992545940952768206080622328123873838\ 
808170496000000000000000000000000000000000000000000000OOOOO~ 

000000000000000000000000 

Another example is the recursive calculation of Fibonacci numbers: 

In[148]:= fib1 [0] = 0; 
fib1 [1] = 1; 
fib1 [n_Integer?NonNegative] : = fib1 [n - 1] + fib1 [n - 2] 

In[151]:= fib1 [6] 

Out[151]= 8 

But this implementation is useless because the time needed to calculate f ibl for larger 

arguments grows exponentially. This happens because new recursions begin on the right­

hand side of the definition for each summand, thereby calculating the same values over 
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and over again. The following implementation stores the already calculated values dynami­

cally. This speeds up the calculation. 

In[152]:= fib2 [0] = 0; 

fib2 [1] = 1; 
fib2[n_Integer?NonNegative] .­

fib2 [n] = fib2 [n - 1] + fib2 [n - 2] 

In[155]:= fib2 [6] 

Out[155]= 8 

In[156]:= ? fib2 

Global'fib2 

fib2 [0] 0 

fib2[1] = 1 

fib2[2] 1 

fib2[3] = 2 

fib2[4] 3 

fib2[5] 5 

fib2[6] = 8 

fib2[(n_Integer) ?NonNegative] := fib2[n] = fib2[n - 1] + fib2[n - 2] 

The efficiency of both variations is dramatically different. (For a fair comparison, values 

which have already been calculated for fib2 must first be cleared.) 

In[157]:= Clear [f ib2] ; 
fib2 [0] = 0; 
fib2 [1] = 1; 
fib2[n_Integer?NonNegative] .-
fib2 [n] = fib2 [n - 1] + fib2 [n - 2] 

In[161]:= Timing [fib1 [26]] 

Out[161]= {18 .1167 Second, 121393} 

In[162]:= Timing [fib2 [26]] 

Out[162]= {O. Second, 121393} 
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In the following section, we will discuss a procedural implementation which increases 

efficiency but reduces readability . 

• 4.4.4 Procedural Programming 

Mathematica contains the branches If, Which, Switch and the loops Do, While, For 

for procedural programming. Do and Whi Ie can be useful. The For loop is a concession 

to C programmers; it often leads to badly structured programs. 

If can process two to four arguments: If [condition, ifTrue, ijFalse, otherwisel. 

In[163]:= Table[If[PrimeQ[n], n, FactorInteger[n]], {n, 2, 10}] 

Ou1[163]= { 2, 3, {{ 2, 2}}, 5, {{ 2, l}, {3, l}}, 

7, {{2, 3}}, {{3, 2}}, {{2, l}, {5, l}}} 

The variation otherwise handles cases where the test function does not evaluate to True 

or False: 

In[164]:= If [NonNegative [#], "nonnegative", "negative", "unknown"] & /@ 
{-1, 0, 1, a} 

Out[164]= {negative, nonnegative, nonnegative, unknown} 

Which processes an even number of arguments where every test is followed by the result 

that must be returned if the test yields True. The tests are processed from left to right 

until the first True. 

Let us look at the function 

In[165]:= intervals[x_] = Whicb[x < 0, 0, x<l, 1, x<2, 2]; 

and evaluate it for the elements of the following list: 

In[166]:= intervals /@ {- .5, .5, 1.5, 2.5} 

Out[166]= {O, 1, 2, Null} 

Values ~ 2 are not anticipated by this function: Which yields the symbol Null. We can 

catch such exceptions by entering True as the last test. 

In[167]:= interval Test [x_] = 
Whicb[x < 0, 0, x < 1, 1, x < 2, 2, True, "outside"]; 
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In[168):= intervalTest /@ {-.s, .5, 1.5, 2.s} 

Out[168)= {O, 1, 2, outside} 

Swi tch tests a given expression on patterns. After the expression, pairs of patterns and 

the corresponding results follow. Here the exceptions can be caught with a blank. 

In[169):= analyze [x_] : = 
Switch[x, _A2, nquadratic", _A3, ncubic", _, "othern ] 

In[170):= analyze /@ {a, a A2, a A3, a A6} 

Out[170)= {other, quadratic, cubic, other} 

Do is analogous to Table, except that it does not yield a result. We illustrate such a loop 

with the Pr in t function. 

In[171):= Do [Print [1/ x], {x, s}] 

1 

1 

2 

1 

3 

1 
4 

1 

5 

The following little program calculates Fibonacci numbers with a Do loop, by beginning 

with the first two (0 and 1) and calculating the higher ones by adding the two preceding 
ones. By working with a list containing the values of two successive Fibonacci numbers, 

we arrive at a very elegant program. It is more efficient than the recursive ones regarding 

memory and compute time. On the other hand, with the recursive program, we can immedi­

ately see how it works, whereas here we have to think about it a bit first. 

In[172):= fib3 [n_] : = Module [{fnl = 0, fn2 = 1}, 
Do[{fnl, fn2} = {fnl+ fn2, fnl}, {n}]; 
fnl] 

In[173):= fib3 [200] 

Out[173)= 280571172992510140037611932413038677189525 
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There are even faster methods for calculating Fibonacci numbers. The built-in function 

Fibonacci uses such an algorithm. 

The While function uses a test as the first argument and as the second a compound 

expression (single expressions divided by semicolons). Here the various possibilities for 

manipulating iteration variables (see Section 2.4.4 of the Mathematica Book) can be 

useful, for example ++. 

In[174]:= Module[{n = 1, t}, t = n; While[n <= 4, t = x+ lit; n++]; t] 

1 
Out[174]= X+X+_1_ 

x+ l:X 

If necessary the program flow may be controlled using Return, Continue, Break, 

and Ca tchiThrow. 

• 4.4.5 Modularity 

For the developer of a Mathematica package, the danger of name collisions does not only 

exist for auxiliary variables (which can be localized using Module), but also for the 

function names themselves. It might happen that two programmers of packages use the 

same name for functions which solve very different tasks. For this reason, Mathematica 

places every name into a so-called context. Each package creates its own contexts and uses 

these for its names. 

Context names are marked with back quotes (') and organized hierarchically. If a ' comes 

first, it is to be taken relatively. Two contexts are predefined: 

• Global' contains the names entered by the user during the working session, 

• System' contains the names built into the kernel. 

The function Context shows the context of a name: 

In[175]:= Context [x] 

Out[175]= Global' 

In[176]:= Context [Integrate] 

Out[176]= System' 

We can manually introduce the name x into the context myContext'. This makes it 

different from an x in the Global' context: 
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In[177]:= myContext' x - x 

Out[177]= -x + myContext' x 

A Mathematica package must use BeginPackage-EndPackage and Begin-End in 

such a way that the exported names are placed in the context of the package and the 

hidden names in a private sub-context. The following template shows how to do this: 

BeginPackage ["PackageName' ", {"Neededl' ", II Needed2 ' ", ... } 1 

Functionl: :usage = II Functionl [xl calculates ... " 

hiddenVariable = ... 

Functionl[x_l 

End[l 

EndPackage [ 1 

PackageName' stands for the context name of the package and should be chosen to 

reflect its contents. Conventionally, the corresponding package file (see below) should be 

named PackageName. m. 

The list of context names {"Neededl''', "Needed2' " , ... } is only necessary if the 

package is based on other packages which must be loaded automatically. Otherwise it can 
be left out. 

A short documentation of every exported object (Functionl) must be placed between 

BeginPackage and Begin. These usage statements are defined as strings containing 

the documentations. They can be accessed by the user of the package (e.g. ?Functionl). 

Begin opens a private sub-context which automatically hides new names introduced here 

(hiddenVariable). Because the context name of the package (PackageName') 

should be unique when the package is loaded, the relative sub-context name 'Pr iva te ' 

can always be used. 

A simple package will usually be passed on in the form of a formatted notebook, which 

contains the Mathematica code and examples, and a package file. In order that everything 
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functions properly, the code in the notebook, i.e. all the input cells between BeginPack­

age and EndPackage, must be marked as initialization cells (menu Cell> Cell Proper­

ties> Initialization Cell). When saving, a message appears asking whether the initializa­

tion cells should be saved into a package file. After selecting Create Auto Save Package, 

Mathematica will create a file named PackageName. m, which can be loaded as usual 

with «PackageName' . Changes in the notebook file are automatically carried over to 

the package file. Both files should be placed into the Applications or Autoload 

directory (sub-directories of AddOns in Mathematica's installation directory). If these 

directories are write protected, the personal Mathematica directory can be chosen. In this 

way the file will safely be found and in case of Autoload it will even be loaded automati­

cally when a kernel is launched. 

Names and arguments of exported functions should be chosen similar to existing Mathemat­

ica functions, so that the user will easily become acquainted with the new functions . 

• 4.4.6 Compiling Numerical Calculations 

The efficiency of numerical calculations can be increased with the Compile function. Its 

arguments are analogous to Function (see the section about pure functions). Additional 

information about the types of arguments can be given. 

The following calculation is speeded up through compilation by about factor 4. First, we 

compile the expression. 

In[178]:= compiledExpression = Compile [x, 
1 + x + x 2 

2 + x - 5 x 2 - x 3 

Out[178]= . . [ 1 + x + x 2 . 1 d d 1 ComplledFunctlon {xl, 2 5 2 3' -Compl e Co e-
+x- x -x 

This object can be applied to an argument just like a pure function. 

In[179]:= compiledExpression [1. 5] 

Out[179]= -0.426966 

For a comparison with an uncompiled variation, we loop a couple of times. 

In[180]:= Timing [Do [compiledExpression [1. 5], {10000}]] 

Out[180]= { 0 .3 Second, Null} 
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1 + 1. 5 + 1. 52 
In[181]:= Timing[Do[ I {lOOOO}]] 

2 + 1. 5 - 5 1. 52 - 1. 53 

Oul[181]= {1 .25 Second, Null} 

For complex arguments, the compilation would look like this: 

In[182]:= compiledComplexExpression = 

Oul[182]= 

1+x+x2 
Compile [ {{x, _Complex}} I 

2 + x - 5 x 2 - x 3 

. . [ { 1 + x + x 2 . 1 1 ComplledFunctlon x}, 2 5 2 3' -Compl edCode-
+x- x -x 

In[183]:= compiledComplexExpression[2. + 3. I] 

OUI[183]= - 0 . 1142 17 + 0 . 09 9 4 8 9 I 

• Exercises 

• Newton's Algorithm 

Part 4 

The application of Newton's algorithm to the polynomial i - 3 yields an approximation for {3. 
Program it first functionally, then procedurally. 

• Fibonacci Numbers 

Program the calculation of the Fibonacci numbers using a procedural algorithm which does not work 
with lists (like f ib3). 

Compare the timings of all program variations. Do not forget that the recursive implementation 

fib2 stores all calculated values. They must therefore be deleted before a comparison is made. 

• Packages 

Create a package which defines and exports the function for gradient calculation (exercises to 

Section 3.2). Use the name Grad (Gradient is already taken by an option of FindMinimum). 

• Programming 

If you have a small programming exercise for a procedural language handy, try to solve it III 

Mathematica. Consider if a functional or a rule-based algorithm would also be possible. 
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.4.5 Further Information 

• 4.5.1 Internet 

The Web site of Wolfram Research (http://www.wolfram.com/). the company behind 

Mathematica, is worth a visit. There you will find among other things up-to-date informa­

tion about the program and FAQs (frequently asked questions). It is a good idea to consult 

the FAQ page before contacting the support team support@wolfram.com (you should 

indicate your license number $LicenseID, version $Version, and operating system). 

The Usenet conference comp.soft-sys.math.mathematica is frequented by beginners and 

experts to Mathematica. 

• 4.5.2 MathSource 

Wolfram Research's MathSource server at http://www.mathsource.com/contains note­

books and packages for various types of applications. Many of them are free. 

• 4.5.3 Literature 

The amount of literature about Mathematica is growing quickly, with well over one 

hundred books extant at present. You will find an up-to-date list on the Web site of 
Wolfram Research. Go to http://www.wolfram.com!and follow the links> Products & 

Store> Mathematica Boqkstore. 

You might also be interested in the Mathematica Journal which is published on the Web. 

Check out the site http://www.mathematica-journal.com/. 
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